
Oracle® Fusion Middleware
Using Oracle GoldenGate Studio

12c (12.2.1.4.0)
E95645-01
September 2019



Oracle Fusion Middleware Using Oracle GoldenGate Studio, 12c (12.2.1.4.0)

E95645-01

Copyright © 1997, 2019, Oracle and/or its affiliates. All rights reserved.

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify,
license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means.
Reverse engineering, disassembly, or decompilation of this software, unless required by law for
interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on
behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software,
any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are
"commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the
programs, including any operating system, integrated software, any programs installed on the hardware,
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications.
It is not developed or intended for use in any inherently dangerous applications, including applications that
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron,
the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro
Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products,
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly
disclaim all warranties of any kind with respect to third-party content, products, and services unless otherwise
set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates will not be
responsible for any loss, costs, or damages incurred due to your access to or use of third-party content,
products, or services, except as set forth in an applicable agreement between you and Oracle.



Contents

 Preface

Documentation Accessibility vii

Related Information vii

Conventions vii

1   Introducing Oracle GoldenGate Studio

1.1 Introduction 1-1

1.2 How Do I Get Started? 1-1

2   Using the Interface

2.1 Understanding the User Interface Basics 2-1

2.1.1 Oracle GoldenGate Studio Repository Login 2-2

2.1.2 Menu Options 2-3

2.1.2.1 The File Menu 2-4

2.1.2.2 The Edit Menu 2-4

2.1.2.3 The View Menu 2-5

2.1.2.4 The Search Menu 2-5

2.1.2.5 The Diagram Menu 2-5

2.1.2.6 The OGG Menu 2-7

2.1.2.7 The Tools Menu 2-8

2.1.2.8 The Window Menu 2-8

2.1.2.9 The Help Menu 2-9

2.2 Setting Your Preferences 2-10

2.2.1 How to Set Preferences 2-10

2.3 Using the Keyboard Navigation 2-10

2.4 Using the Projects Navigator 2-11

2.5 Using the Editor Area 2-11

2.6 Using the Resources Navigator 2-13

2.6.1 Adding a New Database Connection 2-15

2.6.2 Adding a New Big Data System Connection 2-17

2.6.3 Adding a New Global Mapping Group 2-18

iii



2.6.4 Adding a New Oracle GoldenGate Instance 2-19

2.7 Using a Custom Parameter File 2-21

2.8 Using the Properties Inspector 2-22

2.8.1 How to Use the Properties Inspector 2-23

2.8.1.1 Viewing or Modifying Big Data Properties File 2-23

3   Working with Solutions and Deployment Profiles

3.1 Understanding Projects 3-1

3.1.1 Creating a Project 3-1

3.2 Understanding Solutions 3-1

3.2.1 Creating a New Solution 3-2

3.3 Understanding Deployment Profiles 3-3

3.3.1 Components of the Deployment Profile 3-4

3.3.1.1 Name of the Oracle GoldenGate profile 3-4

3.3.1.2 Deployment Architecture Template 3-4

3.3.1.3 Assign Physical Resources 3-5

3.3.1.4 Deployment Configuration 3-5

3.3.2 Consolidation of Capture 3-6

3.3.3 Toolbars in the Deployment Profile 3-6

3.3.4 Creating a New Deployment Profile 3-7

4   Working with Mappings Groups

4.1 Understanding Mapping Groups 4-1

4.1.1 Schema and Table Mapping 4-1

4.1.2 Column Mapping 4-3

4.1.3 Automap 4-5

4.2 Creating a Mapping Group 4-5

4.3 Assigning Mapping Groups to a Replication Path 4-6

4.4 Copying And Sharing Mapping Groups 4-6

5   Deploying and Monitoring Your Solutions

5.1 Deploying Solutions 5-1

5.1.1 Deploying a Solution 5-2

5.1.2 Viewing Report Files and GGSERR.LOG Files 5-2

5.2 Overview 5-2

5.2.1 Definition 5-2

5.2.2 Deployment History 5-3

5.2.3 Monitoring 5-3

5.2.4 Deployment Configuration 5-4

iv



5.2.5 Oracle Data Pump 5-5

6   Managing Security

6.1 Understanding Security in Oracle GoldenGate Studio 6-1

6.2 Using the Security Navigator 6-1

6.2.1 Adding a New User 6-2

6.2.2 Modifying an Existing User 6-2

6.2.3 Deleting an User 6-3

6.3 Deleting a Secure Wallet 6-3

7   Troubleshooting

7.1 Positioning of Docked Windows 7-1

7.2 Performance Issues While Using Oracle GoldenGate Studio 7-1

7.3 Privilege Issue with Oracle GoldenGate Studio 7-1

7.4 Syntax Errors with Generated Code 7-1

7.5 Not Able to Add Resources 7-1

A   Concepts and Terminology

B   Oracle GoldenGate Commands and Parameters that you can use
with the Properties Inspector

B.1 Commands with Options B-1

B.1.1 ADD EXTRACT Commands B-1

B.1.2 ADD REPLICAT Commands B-2

B.1.3 ADD EXTTRAIL Command B-3

B.1.4 ADD RMTTRAIL Command B-4

B.1.5 REGISTER EXTRACT Command B-4

B.1.6 START EXTRACT Command B-4

B.1.7 START REPLICAT Command B-5

B.1.8 ADD TRANDATA Command B-5

B.2 Parameter Category Names B-6

B.3 Units of Measure B-6

B.4 Opposites B-8

B.5 Other Oracle GoldenGate Parameters/Options B-14

C   Oracle Oracle GoldenGate Studio Accessibility Information

C.1 Oracle GoldenGate Studio Features that Support Accessibility C-1

v



C.1.1 Keyboard Access C-1

C.1.2 Screen Reader Readability C-2

C.1.3 Flexibility in Font and Color Choices C-2

C.1.4 No Dependency on Blinking Cursor and Animation C-3

C.1.5 Screen Magnifier Usability C-3

C.2 Highly Visual Features of Oracle GoldenGate Studio C-3

vi



Preface

This preface describes the document accessibility features and conventions that are
used in Oracle GoldenGate Studio Documentation.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=docacc.

Accessible Access to Oracle Support

Oracle customers who have purchased support have access to electronic support
through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/
lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?
ctx=acc&id=trs if you are hearing impaired.

Related Information
The Oracle GoldenGate Product Documentation Libraries are found at

https://docs.oracle.com/en/middleware/goldengate/index.html

Additional Oracle GoldenGate information, including best practices, articles, and
solutions, is found at:

Oracle GoldenGate A-Team Chronicles

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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1
Introducing Oracle GoldenGate Studio

Oracle GoldenGate Studio allows you to quickly create, modify, validate, deploy, and
reuse Oracle GoldenGate designs.
Topics:

1.1 Introduction
Oracle GoldenGate Studio enables you to design and deploy high-volume, real-time
replication by automatically handling table and column mappings, allowing drag and
drop custom mappings, generating best practice configurations from templates, and
contains context-sensitive help. With Oracle GoldenGate Studio, users new to Oracle
GoldenGate can start replicating data with minimal effort while experienced users have
access to GoldenGate's advanced replication options. Users new to Oracle
GoldenGate can start replicating data with minimal effort. Oracle GoldenGate Studio
provides you with the following abilities:

• Quickly create, modify, validate, deploy, and reuse Oracle GoldenGate best
practice designs.

• Define data flows once and deploy to numerous locations.

• Graphically filter, map, and transform data.

• Apply global rules and exceptions.

1.2 How Do I Get Started?
To understand what is available in the product and documentation, Oracle
recommends that you familiarize yourself with the Concepts and Terminology and the 
Oracle GoldenGate Commands and Parameters that you can use with the Properties
Inspector so that you have an understanding of what are available in the product and
documentation.

You can follow the basic steps outlined below to create and deploy your replications:

OGG Roadmap Summary

Roadmap of Tasks

1. Begin by adding new database and Oracle GoldenGate connections to your
Global Resource Library, see Understanding Projects.

2. Use the wizards to create a Project, Replication Solution, and Deployment Profile.
By default each wizard invokes the next. Solutions define the replicat process. The
Solution and Deployment Profile wizards provide you with preconfigured
templates, see Understanding Solutions.

3. Solution objects own Mapping groups, which describe the logical view of the
replication process. Use the AutoMap button or manually map the schema, table,
and column mappings and then assign them to your replication paths, see 
Understanding Mapping Groups.
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4. Create Mapping groups and assign them to the appropriate replication paths. You
can reuse the Solution Mapping groups in multiple replication paths for that
solution and the Global Mapping groups across multiple replication paths across
the project, see Understanding Mapping Groups.

5. Add, remove, and fine tune any Oracle GoldenGate option or parameter, see 
Using the Properties Inspector.

6. Deploy the Solution online to live Oracle GoldenGate instances or generate the
parameter and obey files locally for manual deployment, see, Understanding
Deployment Profiles.

7. Define any additional physical resources and assign them to your deployment
profiles through the drag and drop option from the Global Resource Library to the
Deployment Profile diagram, see Understanding Deployment Profiles.

8. Solutions also own one or more Deployment Profiles, which describe the physical
attributes of a particular replicat deployment. You can create multiple deployment
profiles. For example, separate profiles for development, testing, and production
for a single Solution, see Understanding Deployment Profiles.

9. View deployment history information, see Understanding Deployment Profiles.

10. Start, stop, and monitor all physical processes, see Monitoring .

11. Export solutions and mappings to XML files that can be imported by other Oracle
GoldenGate Studio users, see Using the Projects Navigator.

Chapter 1
How Do I Get Started?
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2
Using the Interface

Learn how to use the interface to easily create, modify and deploy Oracle GoldenGate
replication solutions.
Topics:

2.1 Understanding the User Interface Basics
Oracle GoldenGate provides a highly optimized user interface for easy creation,
modification, and deployment of Oracle GoldenGate replication solutions.

There are two visible sections that appear when Oracle GoldenGate Studio is started.
The Projects Navigator is visible on the left and the Start Page is visible on the right.

Screens shown in this guide may differ from your implementation, depending on the
skin and icons used. Any differences are cosmetic.

Figure 2-1    Oracle GoldenGate Studio Main Window

The interface includes the tabbed editor area with a selection of other windows. The
primary windows that are used with the editor area when you design and deploy
Oracle GoldenGate replication solutions are:

• Projects Navigator
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• Resources Navigator

• Properties Inspector

• Components Window

• Log Messages Window

• Security Navigator

You can also use the Tab key to change focus within a component and the keyboard
shortcut Ctrl+Tab to change focus between different components.

2.1.1 Oracle GoldenGate Studio Repository Login
Use the Oracle GoldenGate Studio Repository login to connect to Oracle GoldenGate
Studio. The required connection details are:

Studio Connection

• LoginName: Oracle GoldenGate Studio login name defined in the repository.

• User: Oracle GoldenGate Studio user name.

• Password: Oracle GoldenGate Studio user password.

Database Connection

• User: The name of the repository.

• Password: The password for the repository.

• Driver List: The name of the selected driver.

• Driver Name: Name of the login defined to the repository.

• URL: For Oracle database, this is the URL of the driver. For MySQL database, this
is the repository name which is same as User.

For example, if the User is TEST_REPO, the URL should also be TEST_REPO.

You can click New to create a new Oracle GoldenGate Studio login. You save your
first repository connection definition by using a secure wallet. The secure wallet is
password protected, see Deleting a Secure Wallet.

Click Edit to modify the existing Oracle GoldenGate Studio login with the Repository
Connection Information Editor.

Click Copy to copy a current login definition.

Click Delete to delete an existing Oracle GoldenGate Studio login.

For more information on repository database tables, see description of repository
tables.

Chapter 2
Understanding the User Interface Basics
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Note:

• To improve performance, the repository database needs to be in the
same LAN as the machine using Oracle GoldenGate Studio.

• Oracle GoldenGate Studio supports Oracle and MySQL database for
repository.

• To create the repository with MySQL 5.7 database, use the following
command:

set @@global.show_compatibility_56=ON;

Privileges Required to Create Repository

The following privileges are required for create the repository:

grant dba to oggstd;
GRANT EXECUTE ON DBMS_LOB TO oggstd with grant option;
GRANT EXECUTE ON DBMS_OUTPUT TO oggstd with grant option;
GRANT EXECUTE ON DBMS_STATS TO oggstd with grant option;
grant execute on sys.dbms_aq to oggstd with grant option;
grant execute on sys.dbms_aqadm to oggstd with grant option;
grant execute on sys.dbms_aqin to oggstd with grant option;
grant execute on sys.dbms_aqjms to oggstd with grant option;
grant execute on sys.dbms_aqadm to oggstd with grant option;
grant execute on sys.dbms_aq to oggstd with grant option;
grant execute on utl_file to oggstd with grant option;
grant execute on dbms_lock to oggstd with grant option;
grant select on sys.V_$INSTANCE to oggstd with grant option;
grant select on sys.GV_$INSTANCE to oggstd with grant option;
grant select on sys.V_$SESSION to oggstd with grant option;
grant select on sys.GV_$SESSION to oggstd with grant option;
grant select on dba_scheduler_jobs to oggstd with grant option;
grant select on dba_scheduler_job_run_details to oggstd with grant option;
grant select on dba_scheduler_running_jobs to oggstd with grant option;
grant select on dba_aq_agents to oggstd with grant option;
grant execute on sys.DBMS_SHARED_POOL to oggstd with grant option;
grant select on dba_2pc_pending to oggstd with grant option;
grant select on dba_pending_transactions to oggstd with grant option;
grant execute on DBMS_FLASHBACK to oggstd with grant option;
grant execute on dbms_crypto to oggstd with grant option;
GRANT EXECUTE ON DBMS_REPUTIL TO oggstd WITH GRANT OPTION;
GRANT execute on dbms_job to oggstd with grant option;
grant select on pending_trans$ to oggstd with grant option;
grant select on dba_scheduler_job_classes to oggstd with grant option;
GRANT SELECT ON SYS.DBA_DATA_FILES TO oggstd WITH GRANT OPTION;
GRANT SELECT ON SYS.V_$ASM_DISKGROUP TO oggstd WITH GRANT OPTION;

2.1.2 Menu Options
The menu options available in Oracle GoldenGate Studio are as follows:

Chapter 2
Understanding the User Interface Basics

2-3



2.1.2.1 The File Menu
Use this menu for file related activities, such as:

Menu option Description

New: Use to create a new project, solution,
deployment profile, mapping group, data
server connection, Oracle GoldenGate
instance connection, and global mapping
group.

Open: Use to open a file.

Close: Use to close the current editor tab.

Close All Use to close all the open editor tabs.

Delete: Use to delete the currently selected object. If
nothing is selected, this is grayed out.

Save: Use to save any changes done in the current
editor tab.

Save All: Use to save the changes in all open editor
tabs.

Page Setup, Print, Print Preview, Print
Area:

Use to set up the print options.

Exit: Use to quit Oracle GoldenGate Studio.

2.1.2.2 The Edit Menu
Use the Edit menu for editing locally generated parameter and obey files. Any edits to
these files not retained in the repository and are overwritten the next time the files are
generated. Functions include:

Menu Option Description

Cut: Use to cut the selected item.

Copy: Use to copy the selected item.

Paste: Use to paste the selected item.

Delete: Use to delete the selected item.

Duplicate Selection: This is grayed out.

Multi-Cursor: Use to enable the multi-cursor functionality.
This menu is available when a text file is
opened in the editor.

Select All: Use to select the available on-screen items.

Block Selection: Use to select a text block. This menu is
available when a text file is opened in the
editor.

Properties: Use to open the Properties Inspector for an
item.

Chapter 2
Understanding the User Interface Basics
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2.1.2.3 The View Menu
Use the View menu for viewing the toolbar, the status bar, and the related viewing
areas. Functions include:

Menu Option Description

Editor: Use to display the options available for editor.

Show Toolbars: Use to view different toolbars such as Main,
Code Editor, Properties, and Structure.

Show Status Bar: Use to display the status bar.

Refresh: Use to refresh the viewing area. If you refresh
the editor tab, a dialog box displays to confirm
if you wish to revert back to the last saved
copy. You can use this method as an
alternative to the undo operation.

Full Screen: Use to display the product in full screen mode.

Show Only Editor: Use to display only the editor area.

2.1.2.4 The Search Menu
Use the Search menu to find individual items in Oracle GoldenGate Studio. The
available options are:

Menu Option Description

Find: Use to find a particular item.

Find Next: Use to find the next instance of a particular
item.

Find previous: Use to find the previous instance of a
particular item.

2.1.2.5 The Diagram Menu
Use the Diagram menu to view and optimize the diagrams. This menu is visible only
when the Solution Editor or the Deployment Profile editor is selected. The options
include:

Menu Option Description

Upload GoldenGate Files...: Use to upload the Oracle GoldenGate files.
The specified location must exist to complete
this operation.

Generate GoldenGate Files...: Use to generate the Oracle GoldenGate files.
The specified location must exist to complete
this operation.

Chapter 2
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Menu Option Description

Deploy: Use to deploy the solution. The status of the
deployment action is displayed in the
messages log. Online deployment is possible
at a solution level, Oracle GoldenGate
instance level, host level, and processes level.
This option is enabled only when an Oracle
GoldenGate instance is associated with an
actual Oracle GoldenGate instance resource.

Validate Deployment Profile: Use to validate the deployment profile. The
validation checks if any database specific
options were incorrectly used. For example, if
you indicate in the Oracle GoldenGate
connection that the database is Oracle but try
to deploy to SQL Server, the validation
connects to the Oracle GoldenGate instance
and a warning is displayed in messages log, if
any Oracle specific options like integrated
capture were used.

Synchronize Profile with solution: Use to synchronize the deployment profile with
a solution. This option is enabled only when
the profile is not synchronized with the
solution.

Start: Use to start the selected process

Start...: Use to start the selected process with
additional options.

Stop: Use to stop the selected process.

Kill: Use to terminate the selected process.

Chapter 2
Understanding the User Interface Basics
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Menu Option Description

Alter Command: Use the Alter command to display either the
Alter EXTRACT or the Alter REPLICAT
dialog boxes.

Use the Alter Extract dialog box to:

• change the attributes of an Extract group
created with the ADD EXTRACT
command.

• Increment a trail to the next file in the
sequence.

• Upgrade to an integrated capture
configuration.

• Downgrade from an integrated capture
configuration.

• Position any given IBM for a journal at a
specific journal sequence number.

• Position any given Informix logical log at a
specific LSN.

Use the Alter Replicat dialog box to change
the attributes of a Replicat group that was
created with the ADD REPLICAT command:

• A Non Integrated option switches
Replicat from integrated mode to non-
integrated mode.

• An Integrated option switches Replicat
from non-integrated mode to integrated
mode.

Optimize Graphic Size: Use to set the optimal size of the graphic
element.

Bring to Front: Use to bring the selected graphic to the top
layer.

Send to Back: Use to send the selected graphic to the bottom
layer

Zoom: Use to select the selected graphic to the
required zoom level. You can select a defined
zoom level, zoom in, zoom out, fit window, or
zoom to a selected level.

2.1.2.6 The OGG Menu
Use the Oracle GoldenGate (OGG) menu includes the following options:

Menu Option Description

Connect: Use to connect to the repository.

Disconnect: Use to disconnect from the repository.

Chapter 2
Understanding the User Interface Basics
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Menu Option Description

Repository Information: Use to display detailed information about the
Studio connection and Database connection.
The Studio connection includes the Studio
Login Name and password that was defined
while creating the repository. One account can
have the SUPERVISOR privilege while other
accounts are non supervisor. SUPERVISOR is
able to create and modify other users. The
Database connection includes the database
user name for the repository schema and the
associated password, driver name
(oracle.jdbc.OracleDriver), and the JDBC URL.

Change Current User’s Password: Use to change the password for the current
user. User have to type both, the existing and
the new password.

Solution: Use to synchronize all profiles for a solution.

Deployment: Use for online deployment, generate the
Oracle GoldenGate parameter and obey files
for offline deployment, and to validate the
deployment profile.

2.1.2.7 The Tools Menu
The Tools menu includes the following option:

• Preferences: Use to set the preferences. See Setting Your Preferences section
for more information.

2.1.2.8 The Window Menu
Use the window menu to display different window within the editor. The available
options are:

Menu Option Description

Projects Navigator: Use to display the Projects Navigator window.
You can view all the available projects,
solutions, deployment profiles, and mapping
groups.

Security Navigator: Use to display the Security Navigator window.
This is greyed out for a non supervisor user.

Components: Use to display the Components window.
Components are only displayed when the
Solution diagram editor is selected.

Extension Diagnostics Use to display the extension logs.

Log: Use to display the Log Messages Explorer.

Properties: Use to display the Properties Navigator
window.

Chapter 2
Understanding the User Interface Basics
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Menu Option Description

Resources: Use to display the Resources Navigator
window. The main components are Global
Mappings, OGG Instances, and Database
Connections.

Structure: Use to view the structural representation of
data of the selected profile. The Structure
window is enabled only when the Solution and
Deployment Profile diagrams are selected.

Thumbnail: Use to display a representation of the current
diagram for quick navigation to a specific
element on the diagram.

Configure Window This menu item consists of a list of sub menu
items to set the window behavior such as
minimize, maximize, float and so on.

Reset Windows To Factory Settings: Use to reset all windows to their default layout.

Assign File Accelerator: Use to assign the file accelerators.

Close Profile profile name: Use to close the active window. This menu
item depends on what is selected.

Close All Documents: Use to close all open documents within the
editor.

Close other documents: Use to close other documents.

Documents Use to display the documents window, which
lists all available documents. You can switch
to a particular document, sort, save, or close a
document.

2.1.2.9 The Help Menu
The help menu includes the following options:

Menu Option Description

Search: Use to search the online help system.

Table of Contents: Use to display the table of contents for the
online help system.

Documentation Library: Use to open a browser window with a link to
the related documentation.

Start Page Use to display the Oracle GoldenGate product
information page. You can learn and explore
the tutorials and help topics from this page.

OGG Studio Forum: Use to open a browser window with a link to
Oracle GoldenGate studio forum posts.

Oracle Technology Network: Use to open a browser window with a link to
Oracle Technology Network.

About: Use to display the About dialog box with
version information.

Chapter 2
Understanding the User Interface Basics
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2.2 Setting Your Preferences
You can set the preferences for Oracle GoldenGate Studio including the environment,
audit behavior, and display.

The main components of this window are:

• Environment: Use to set the undo level, navigation level, and look and feel. All
warning messages can be reset from here.

– Log: Each activity can be logged. You can set the directory for saving log files,
maximum number of log lines, and log color options.

• Audit: This is grayed out.

• Code Editor: Use to open the editor.

• Database: Use to configure different database options. You can also select the
JDBC driver from the list of registered drivers, add a new driver, or delete an
existing driver.

• Diagrams: Use to set the options for diagrams.

– Annotation: Use to set the annotation options like color and font.

• Parameter Editor: Use to open the parameter editor.

• Web Browser and Proxy: Use to configure web browsers, proxy settings and
internet files.

– Web Browsers: Use to set the default web browser.

– Proxy Settings: Use to configure the proxy settings such as no proxy, system
default proxy, automatic proxy settings, and manual proxy settings.

– Internet Files: Use to enable cookies and clear all existing cookies.

2.2.1 How to Set Preferences
To set preferences, do the following:

1. In the Oracle GoldenGate Studio window, from the Tools menu, select
Preferences.

2. Modify individual items as per requirement.

2.3 Using the Keyboard Navigation

This section describes the common methods of moving the cursor in Oracle
GoldenGate Studio.

• Cursor control

• Operate Buttons

• Select Checkboxes

• Dropdown Lists and Combo Boxes

• List Boxes

Chapter 2
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• Radio Buttons

• Shuttles

• Sliders

• Spin Controls

• Text Fields

• Navigating Complex Controls

2.4 Using the Projects Navigator
The Projects Navigator to browse and select existing solutions and solution
components such as Deployment Profiles and Mapping Groups. The list of all active
projects are available through the Project drop-down option. You can refresh the
current project by using the Refresh Projects Window button.

Figure 2-2    Projects Navigator

You can perform the following project related tasks by using the Project Menu:

• Open project: Opens the editor for the selected project. If no project is selected,
this is grayed out.

• New project: Create a new project.

• Duplicate project: Duplicate an existing project and edit it after duplication.

• Delete project: Delete an existing project.

• Import project: Import a project XML file that was exported from Oracle
GoldenGate Studio.

• Export project: Export a project to an XML file.

2.5 Using the Editor Area
The editor area is used to visualize the organization and flow of the logical replication
solution with the physical objects for the physical deployment profile. You can add data
server and replication path components visually by using the drag-and-drop operation
to evolve the solution. The deployment profile architecture can be changed by
selecting any part of the replication path in the deployment profile diagram and
selecting the desired architecture template from the Properties Inspector.

Chapter 2
Using the Projects Navigator
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Both the solution and deployment profile editors have an Overview tab. The Solution
Overview tab contains the solution definition and description and deployment summary
for all deployment profiles that are associated to that solution. The Deployment Profile
Editor Overview tab contains the deployment profile description, deployment history for
this profile only, monitoring, and deployment configuration options.

If using a Bidirectional, Consolidation, or Distribution solution template, a single
replication path is shown and scaled in the deployment view to improve readability.
You can use the drop-down to select the required replication path.

Figure 2-3    Multiple Replication Paths in Design View

The replication paths are displayed as DS 01 -> DS 04, DS 02 -> DS 04, and DS 03 ->
DS 04 in the editor area.
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Figure 2-4    Drop Down List in Deployment View

2.6 Using the Resources Navigator
The resources navigator, or the global resource library lists all the available resources
such as:

• Database: All the available databases.

• Views: Create new views.

• Global Mapping Group: Global mapping groups can be assigned to any replication
path of any solution across all projects. Mapping groups created for a solution in
the Projects Navigator can be copied to the global mapping groups or created
directly from the Resources Navigator.

• Oracle GoldenGate Instance: The available Oracle GoldenGate instances.

The Resources Navigator looks like:
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Figure 2-5    Resources Navigator

There are three ways to add a new global resource:

• If any type of resource is not added then you can add it by selecting the New
button in the Resources Navigator toolbar.

• Add it by select the New button in the Oracle GoldenGate Studio toolbar.

• You also can select New under File menu, and then select the resource type you
want to add.

If a resource type has already been added, you right-click the resource category and
select New Resource Type. You can add a Global Mapping Group by right-clicking a
mapping group in the Projects Navigator and selecting Copy to Global Resource
Library.

Figure 2-6    Adding New Resources through Resources Navigator

You can change the properties of existing resources by using the Properties context
menu. You can also use the keyboard shortcut Ctrl+Tab to navigate to Resources
Navigator, use the Tab and arrow keys to select the particular resource, and use Shift
+ F10 to view the context menu.
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2.6.1 Adding a New Database Connection

New database connections are used only for table metadata to facilitate table mapping
and are not used to define connections used by capture and apply processes. Capture
and apply connections are defined in the Properties Inspector in the Deployment
Profile.

A new database connection wizard looks as follows:

Figure 2-7    New Database Connection

To add a new data server connection:

1. Select the Database resource type in the Resources Navigator window and right-
click to select New Database Connection.

2. In the New Data Server Connection window, add the following:

a. Connection Name: The name of the new connection. The resource is listed in
the Resources Navigator with the name mentioned here.

b. Connection Type: Connection types are Oracle (JDBC), Generic JDBC, MySQL,
SQLServer, DB2 UDB, and Teradata. Changing of database type is not
supported after connection is created.

c. The User name and Password to connect to the database. If you uncheck
Save Password check box during connection creation and if you want to
expand the Database node after reconnecting to repository, Database node
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expansion asks you to enter the password to show all the nodes for the
database connection.

d. The role as SYSDBA or SYSOPER. This can be left blank when the user is not SYS.
Else, you have to select the role.

e. The JDBC settings.

By default, Oracle GoldenGate Studio provides drivers for Oracle, MySQL,
SQL Server, Informix, Sybase, and DB2 UDB. Additional database drivers that
are not provided with the product can be configured by using Tools menu,
then Preferences , Database, and JDBC Driver Options. Once a data server
connection is created, you can browse objects in the database in the
Resources Navigator and you can use the information from the database
navigator for mapping the tasks. Currently Oracle, MySQL, and SQLServer
drivers are certified.

To add the Teradata connection, you have to load the Teradata drivers as
follows:

i. In the New Data Server Connection window, select Teradata as the
connection type.

ii. Click the select Library button.

iii. In the Select Library window, click the New... button.

iv. In the Create Library window that opens, click on Add Entry... button.

v. In the Select Path Entry window that opens, browse to the location where
the Teradata drivers are stored and select the drivers. Click the Open
button.

vi. Click OK if the drivers are correctly added under Class path.

vii. In the Select Library window, you can see the newly added Teradata
drivers. Click OK.

viii. Provide a valid Username and Password and click Test Connection to
perform a connection test or OK to proceed with the connection.
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Figure 2-8    The Select Library Dialog

3. Click OK to create a new Database resource.

You can also test the connection by using Test Connection button before you
create the new resource.

Note:

Teradata is supported as a target only database but you can drag-and-drop
Teradata tables as a source database in the mapping editor. This is possible
as mapping is a logical concept and no check is performed by Oracle
GoldenGate Studio.

Note:

The generate to function for Teradata and DB2 UDB tables depend on
JDeveloper functionality. DB2 UDB to DB2 UDB and Teradata to Teradata
are not supported.

2.6.2 Adding a New Big Data System Connection

A new Big Data system can only be used as a target. Properties for the connection
can be defined in the Properties Inspector in the Deployment Profile.

A new Big Data system connection wizard looks as follows:
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Figure 2-9    New Big Data System Connection

To add a new Big Data system:

1. Select the Big Data System resource type in the Resources Navigator window and
right-click to select New Big Data System Connection.

2. In the New Data Server Connection window, add the following:

a. Name: The name of the new connection. The resource is listed in the
Resources Navigator with the name mentioned here.

b. Description: A short description about the new Big Data System.

3. Click OK to create a new Big Data System resource.

2.6.3 Adding a New Global Mapping Group
The New Global Mapping Group wizard defines a container for table mappings but
does not guide you through the table mapping process. To learn more about defining
table mapping see Understanding Mapping Groups.

A new Global Mapping Group wizard looks as follows:

Chapter 2
Using the Resources Navigator

2-18



Figure 2-10    New Global Mapping Group

To add a new Global Mapping group:

1. Click the New button on the Resources Navigator window or right click on the
database icon and select New Global Mapping Group Connection.

2. Enter the name of the new connection.

3. Enter a short description to identify the resource.

4. Click OK.

2.6.4 Adding a New Oracle GoldenGate Instance

The Add a New Oracle GoldenGate Instance dialog defines a connection to an
existing Oracle GoldenGate installation. This installation must already have the Oracle
GoldenGate manager and jAgent the processes running.

A new Oracle GoldenGate Instance dialog looks as follows:
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Figure 2-11    New Oracle GoldenGate Instance Connection

To add a new Oracle GoldenGate connection:

1. Click the New button on the Resources Navigator window or right click on the
database icon and select New Oracle GoldenGate Instance Connection.

2. In General section, enter the name and description for the new connection.

3. In Host Information enter the Host Name. It is the DNS name of the server where
Oracle GoldenGate is installed.

4. In the Oracle GoldenGate Information section enter the following:

• GoldenGate Version: You can also select the version from the list while
working offline. If there is an active connection and incorrect version is
entered, the correct information is updated to overwrite the incorrect version
when the Test Connection to GoldenGate button is placed.

• GoldenGate Database Type: The database type for which the connection is
created.

• GoldenGate Port: The port number for the Oracle GoldenGate manager
process.

• Agent Username: The JAgent name as specified by the jAgent.username
property in the config.properties file of the jAgent at the time of installation.

• Agent Password: The password for the corresponding username.

• Agent Port: The jAgent port as specified by the jagent.jmx.port property in
the config.properties file of the jAgent. The recommended mode is OEM. If
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the agent mode is OEM, then you have to use jagent.rmi.port. If the agent
mode is OGGMON, then you have to use jagent.jmx.port.

5. Click Test Connection to GoldenGate to verify if the connection is working. The
version and database type is automatically updated on successful connection.

2.7 Using a Custom Parameter File
Use this to upload an already existing or custom parameter files to Oracle GoldenGate
Studio.

Oracle GoldenGate Studio supports uploading of existing parameter files for the
Extract, Replicat, pump processes, and also for Oracle GoldenGate instance
(manager and GLOBALS file).

To upload a parameter file, right-click the Extract or Replicat process and select
Upload GoldenGate File menu item. In the Upload GoldenGate File dialog that is
displayed, click Browse, select the particular parameter file to be uploaded, and click
Open. Click OK to confirm the selection.

The corresponding values from the parameter file are updated in the Properties
Inspector. All the values are available in Properties Inspector are parsed when a
parameter file is uploaded.

Use this method only for online process and parameter level items xx.prm, and not for
initial load process and obey level items xx.oby.

The comments in.prm file are not parsed in this method.

If Oracle GoldenGate Studio is not able to parse a particular parameter, then it does
not stop parsing the custom parameter file and moves on to the next parameter. The
Messages — Log is updated with the discarded parameter. You can view the
Messages — Log by selecting the Window menu and then the Log menu . For errors
such as Array Index Out of Bounds and Null Pointer Exception, the Oracle Diagnostic
Logging (ODL) is updated instead of the Messages — Log.
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Note:

• Oracle GoldenGate Studio creates a new map whenever a parameter file
is uploaded for the replicat process. Multiple new maps are created if
you upload an updated version of the parameter file. To avoid this,
delete any older maps associated with the particular parameter file
before uploading the file again.

• In Oracle GoldenGate Studio, mapping in Extract side is not supported
when using custom parameter file. Do not use the parameter Target
Definitions in Properties Inspector for any Extract process. Before
online deployment, you must follow the steps to create manual map for
the online deployment.

• The maximum length for any parameter unit is 20 characters. You may
receive an error if it exceeds the maximum length.

• To view the updated trail file name, you should save the profile and
reopen it.

• Oracle GoldenGate Studio does not parse the MAPEXCEPTION parameter.

2.8 Using the Properties Inspector
The Properties Inspector to view and edit the attributes of the selected artifacts in the
solution diagram, deployment profile diagram, and mapping editor. You can view a tool
tip with a description of that particular parameter with the right-click option in the
Properties Inspector of the Deployment Profile. The Properties Inspector is dynamic
and the attributes correspond to the different types of items selected in the editor.

Figure 2-12    Properties Inspector

Oracle GoldenGate Commands and Parameters that you can use with the Properties
Inspector contains a list of the options that can appear in the Properties Inspector of
the Deployment View.
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2.8.1 How to Use the Properties Inspector
To use the Properties Inspector, do as follows:

1. In Oracle GoldenGate Studio, navigate to Window menu and select Properties to
display the Properties Inspector.

2. In the Solution Editor, Mapping Editor, or Deployment View select an item for
which you want to change the property.

3. In the Properties Inspector, change the corresponding properties for that particular
item. Some items, such as conflict resolution in the mapping editor, requires

clicking a dynamic gear icon  that appears to the far right when you mouse
over the attribute.

4. Save the changes by using the Save button on the toolbar or by using the Save
option from File menu. The changes in the process parameters are available only
after redeployment or after regeneration of the parameter files.

Note:

Oracle GoldenGate Studio does not validate the values entered by user in
the Properties Inspector. You have to ensure correctness of values to avoid
abnormal behavior.

2.8.1.1 Viewing or Modifying Big Data Properties File
You can now view or modify the Big Data properties file in Oracle GoldenGate Studio.

Note:

This is applicable to process properties only when the Big Data ogginstance
is assigned as a resource.

To view or modify the Big Data Properties file:

1. In the Property Inspector, click Edit adjacent to the Big Data Property File field to
display the content of the property file. Click Browse to select the file and then edit
the content of the selected file in a dialog.

2. Make the required changes in the Big Data Property File dialog and click OK to
save the changes.
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3
Working with Solutions and Deployment
Profiles

Learn how to use the solutions and deployment profiles to configure and manage your
replication solutions using Oracle GoldenGate Studio.
Topics:

3.1 Understanding Projects
A project is a container for a replication solution. Once created, they are presented as
a drop-down list at the top of the Projects Navigator. For more information, see Using
the Projects Navigator.

3.1.1 Creating a Project
To create a Project, do as follows:

1. Click the New button on the toolbar, or from the File menu select New, or select
New Project... from the Project Menu drop-down list in the Projects Navigator.

2. Select Create New Project, then click OK.

3. Enter a name for you project with an optional description, then click Next.

4. (Optional) you can deselect the Continue to Solution Wizard.

5. Click OK.

Your project is created and is displayed in the list of projects.

3.2 Understanding Solutions
Solutions represent the replication patterns supported by Oracle GoldenGate and are
contained in a project. The concept of replication paths and mapping groups are all
part of the logical definition of a solution. Once the logical design is in place, you can
create multiple deployment profiles each with its own deployment template to match
the physical elements of your replication environments. A single Oracle GoldenGate
project can have multiple solutions.

One solution and its table mapping groups can be deployed to any number of physical
locations.

A typical solution contains:

• Deployment Profiles: Describes the deployment architectural template, physical
resources, and additional deployment options.

• Mapping Groups: A collection of source and target table mappings and its
associated replication logic, such as filtering and conflict detection rules table from
the Resources Navigator to the Mapping Editor. Then you can automatically
generate the source and target table mapping associations between the Source
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and Target using Automap or created by using the drag-and-drop between
Source to Target and between Target to Source. Additionally, you can use
wildcard characters (*) in the mappings at the schema and table level. For Oracle
multitenant support you must edit the schema name manually to include the
database name.

Readily available solution templates are available in Oracle GoldenGate Studio and
they greatly reduce the time required to create and deploy a solution.

3.2.1 Creating a New Solution
You can create a new solution as follows:

1. In the Projects Navigator, right-click and select New.

Figure 3-1    New Solution Dialog

2. Provide a name for the solution with an optional description, then click Next.

3. Select a solution template from Unidirectional, Bidirectional, Consolidation,
Distribution, or Hub and Spoke. If you select Consolidation, Distribution, or Hub
and Spoke, you have to enter the number of items.

A description appears for the selected template.
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Figure 3-2    New Solution Template

4. (Optional) you can deselect the Continue with Deployment Profile Wizard .

5. Click Finish.

Your solution is created in the open project and is displayed in the Solutions
Navigator.

The default value is 2 for Consolidation and Distribution and 4 for Hub and Spoke. The
maximum applicable value is 2000 for all the templates.

3.3 Understanding Deployment Profiles
The deployment profile is part of the Oracle GoldenGate Studio solution. It describes
the physical attributes of the replication solution. There can be more than one
deployment profile per solution. For example, one deployment profile for the
development environment, one for the test environment, and one for production.

Figure 3-3    Sample Deployment Profile View
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3.3.1 Components of the Deployment Profile
The different components of the deployment profile are:

3.3.1.1 Name of the Oracle GoldenGate profile
Use this component to add a name and optional description to the deployment profile.

3.3.1.2 Deployment Architecture Template
Use this component to define the architecture of deployment profile. When you use the
Deployment Profile wizard the selected architecture template is applied to each and
every replication path in the solution. However, in the Properties Inspector, individual
replication paths may have different architecture templates.

In Consolidation or Distribution, if you change the deployment template from Source,
Target to any other template, only the corresponding links will be changed to other
templates and not the entire deployment profile diagram.

The available architecture templates are:
Source, Target: The source and target deployment environments contain Oracle
GoldenGate instances that are local to the data servers. Capture and apply are both
done locally.
Target Only (Remote Source): There is only one Oracle GoldenGate instance and it is
local to the target data server. Capture is done remotely from the target.
Source Only (Remote Target): There is only one Oracle GoldenGate instance and it is
local to the source data server. Apply is done remotely from the source.
Hub Only (Remote Source and Target): The Oracle GoldenGate instance is on
staging servers. Capture and apply are both done remotely.
Select the number of hubs from the list box. The numerical values listed are 1, 2, and
3. Based on the number you select from the list box, the Hubs are listed on the
Physical Resources page. For example, if you select 2 from the list box, then you
can find the provision to select 2 Hubs on the Physical Resources page.
Source, Hub, and Target: There are at least 3 Oracle GoldenGate instances. One is
local to the source data server and one is local to the target data server. Capture and
apply are both done locally and data is transmitted through Oracle GoldenGate
instances on hub between the two. Number of hubs can be selected from the list box.
Based on the number you select from the list box, the Hubs are listed on the Physical
Resources assignment page.
Hub, Target (Remote Source):There are two Oracle GoldenGate instances, one on a
staging hub and one on the target data server. Capture is done remotely from the hub
while apply is done locally at the target.
Source, Hub (Remote Target): There are two Oracle GoldenGate instances, one is on
the source data server and one is on a staging hub. Capture is done locally from the
source data server while apply is done remotely from the target data server from the
hub.
Single Host (Local Source and Target): There is only one host and it contains both the
Oracle GoldenGate instance and source and target data servers.
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3.3.1.3 Assign Physical Resources
Use this component to assign your resources to the source, the target, and the hub (if
applicable) of the replication path.

The resource assignment section contains:

Name section Description

Replication Path: It describes the data store mapping
information.

Source: Select the Data Server and Oracle
GoldenGate Instance to use as the source of
each replication path.

Target: Select the Data Server and Oracle
GoldenGate Instance to use as the target of
each replication path.

Hub Select the Data Server and Oracle
GoldenGate Instance to use as the hub of
each replication path.

Note:

Resource assignment can be done through the Deployment Profile editor by
dragging and dropping resources from the Resources Navigator to the
appropriate diagram elements and through the Properties Inspector.

3.3.1.4 Deployment Configuration
Use this component to select several additional options such as initial load of all
targets, and starting of Oracle Data Pump.

Initial load of all targets: If you must copy between systems before changes to the
data are applied, select this option.
Start All Oracle GoldenGate Processes: Select the processes that should be started
after deployment:

• Start Capture Process

• Start Pump Process

• Start Apply Process

Note:

Processes can be started only during online deployment.

• Replication Paths: Displays the selected replication path.
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• OGG Initial Load: Start Oracle GoldenGate initial load processes.

• ODP Initial Load: Start the Oracle Data Pump initial load processes.

• Remote Link: Enables an export from a (source) database identified by a valid
database link. The data from the source database instance is written to a dump
file set on the connected database instance.

• Parallelism: Specifies the maximum number of threads of active execution
operating on behalf of the export job. This execution set consists of a combination
of worker processes and parallel I/O server processes.

3.3.2 Consolidation of Capture
Oracle GoldenGate Studio uses a single capture for a single database. This result in
significant performance enhancement.

Single capture is mainly used in Hub and Spoke solution template and the following
deployment architecture template:

• Source, Target

• Source Only

• Source, Hub, Target

• Source, Hub

• Single Host

To use multiple capture for a single database, multiple solutions must be created.

3.3.3 Toolbars in the Deployment Profile
The toolbar buttons are described in sequence with the following image:

Figure 3-4    Deployment Profile Toolbar

Some buttons Validate and Start are context-sensitive and change color when you
enable them.

• Zoom In: Click to increase the size of the on-screen components.

• Zoom Out: Click to decrease the size of the on-screen components.

• Percent View: Click to set the view to a predefined percentage value.

• Perform Layout: Click to automatically rearrange the components in the
deployment view in an organized way. You can save the layout by using the Save
button in the toolbar or by selecting Save File menu. The data flow is from left to
right.

• Synchronize Profile with Solution: Click to synchronize the deployment profile
with a solution use this option only when the profile is not synchronized with the
solution.
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• Deploy Solution: Click to deploy the solution. The status of the deployment action
is displayed in the Messages log. Online deployment is possible at solution level,
Oracle GoldenGate instance level, host level, and processes level this option only
when an Oracle GoldenGate instance is assigned with an actual Oracle
GoldenGate instance resource.

• Validate Deployment Profile: Click to validate the deployment profile. The
validation checks if any database specific options were incorrectly used. For
example, if you indicated in the GoldenGate connection that the database is
Oracle but try to deploy to SQL Server, the validation connects to the GoldenGate
instance and a warning is displayed if any Oracle specific options like integrated
capture were used. Validation warnings, if any, are displayed in the messages log.

• View Report File: Click to view the Report files.

• Generate GoldenGate Files: Click to choose a local directory in which
GoldenGate files are generated.

• Start the Selected Process: Click to start the selected process.

• Stop the Selected Process: Click to stop the selected process.

• Kill the Selected Process: Click to terminate the selected process.

• Replication Path drop-down list: Click to select the replication path. Only the
components of one replication path at a time can be viewed.

3.3.4 Creating a New Deployment Profile
To create a new deployment profile:

1. Name your Deployment Profile: Provide a name for the deployment profile and
click Next. Click Finish to creates a profile that defaults to the Replication Path,
Source, and Target by using automatically generated names and settings for the
solution.

2. Deployment Template: Select an architecture to be used as the template for the
solution. The deployment architecture template describes where Oracle
GoldenGate is installed in relation to the data servers. The selected template is
applied to all replication paths and can be customized on a replication path-by-
replication path basis subsequently. You can change a previously selected
deployment architecture template by clicking the template link in the Deployment
View and selecting a new template in the Properties Inspector.

Architecture templates available are:

Deployment
Architecture Template

Description

Source, Target The source and target deployment environments contain
Oracle GoldenGate instances local to the data servers.
Capture and apply are both done locally.

Target Only (Remote
Source)

There is only one Oracle GoldenGate instance and it is local to
the target data server. Capture is done remotely from the
target.

Source Only (Remote
Target)

There is only one Oracle GoldenGate instance and it is local to
the source data server. Apply is done remotely from the
source.
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Deployment
Architecture Template

Description

Hub Only (Remote
Source and Target)

The Oracle GoldenGate instance is on staging servers.
Capture and apply are both done remotely. Select the number
of hubs from the list box. The numerical values listed are 1, 2,
and 3. Based on the number you select from the list box, the
Hubs are listed on the Physical Resources page. For
example, if you select 2 from the list box, then you can find the
provision to select 2 Hubs on the Physical Resources page.

Source, Hub, Target There are at least 3 Oracle GoldenGate instances. One is
local to the source data server and one is local to the target
data server. Capture and apply are both done locally and data
is transmitted through Oracle GoldenGate instances on hub
between the two. Number of hubs can be selected from the list
box. Based on the number you select from the list box, the
Hubs are listed on the Physical Resources assignment page.

Hub, Target (Remote
Source)

There are two Oracle GoldenGate instances, one on a staging
hub and one on the target data server. Capture is done
remotely from the hub while apply is done locally at the target.

Source, Hub (Remote
Target)

There are two Oracle GoldenGate instances, one is on the
source data server and one is on a staging hub. Capture is
done locally from the source data server while apply is done
remotely from the target data server from the hub.

Single Host (Local Source
and Target)

There is only one host and it contains both the Oracle
GoldenGate instance and source and target data servers.

Select the deployment architecture template from the list of available templates
and click Next.

Figure 3-5    Deployment Architecture Template
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The contents of the Physical Resources step is populated based on your
deployment template selection.

3. Assign Physical Resources: Use this option to assign your resources to the
source, target, and hub (if applicable) of the replication path.

Source
Select the Data Server and Oracle GoldenGate instance to use as the source of
each replication path.

Target
Select the Data Server and Oracle GoldenGate instance to use as the target of
each replication path.

Hub
Select the Data Server and Oracle GoldenGate instance to use as the hub of
each replication path.

Note:

Resource assignment can also be done through the Deployment Profile
editor by dragging and dropping resources from the Resources
Navigator to the appropriate diagram elements and through the
Properties Inspector.

The deployment template is the same for all replication paths in a given solution.
Some templates do not require data stores.
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Figure 3-6    Physical Resources in Deployment Profile

4. Deployment Options: Select or deselect any applicable Oracle GoldenGate
starting process deployment options.

Initial load of all targets
If data between systems before changes to the data are applied, select this
option.

Start All Oracle GoldenGate Processes
Select the processes that should be started after deployment. Processes
available are:

• Capture Processes

• Pump Processes

• Apply Processes

Note:

Processes can be started only during online deployment.
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Figure 3-7    Deployment Options

Click Finish. Your deployment profile is created and added to the Solution.
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4
Working with Mappings Groups

Learn how to use the local and global mappings groups to create, configure, copy, and
manage your replication options by using Oracle GoldenGate Studio.
Topics:

4.1 Understanding Mapping Groups
In Oracle GoldenGate Studio, the term mapping group is used to explain a collection
of source and target table mappings and its associated replication logic such as
filtering and conflict detection rules. First, you must drag and drop or add the tables by
using the keyboard shortcuts from the Resources Navigator to the Mapping Editor.
Then you can automatically generate between Source and Target table mapping
associations by using Automap option or by drag-and-drop operation or by using
keyboard shortcuts between Source to Target and between Target to Source.
Additionally, you can use wildcard characters (*) in the mappings at the schema and
table level. If you drag and drop the schema name it automatically use a wildcard,
indicating all tables. For more on wildcard logic see the Reference for Oracle
GoldenGate

For Oracle multitenant support you must edit the schema name manually to include
the pluggable database name, only the metadata from the database connections are
used. This means mapping groups are logical constructs, which can be assigned to
multiple replication paths. Mapping groups local to a solution can be associated with
any replication path in that solution, while global mapping groups located in the global
resource library, can be used for any replication path for any solution across all
projects. When a mapping group is modified that change is reflected in all replication
paths that references that mapping group. More than one mapping group can be
assigned to a replication path.

For example, if you have 100 stores with the same application schema reporting back
to a central data warehouse, you only have to define that mapping group once and you
can apply it to all 100 replication paths. Any changes to that mapping group only
needs to be made once and it is reflected in all 100 replication paths.

4.1.1 Schema and Table Mapping

Schemas are not directly mapped to other schemas. Tables in the schemas are
mapped to other tables. To map all tables in a schema you can either highlight of the
tables in the global resource library and drag and drop them into the mapping editor or
you can drag and drop the schema name, which then uses a wildcard (*) for all tables.
If replicating DDL and want to capture new tables then, always use a wildcard. You
can use a wildcard with schema names. However, when you use a wildcard for
schema names, some system schemas are automatically excluded. To see schema
names that are implicitly excluded when you use wildcards, see olink:GWUAD-
GUID-46CAAFC3-DCA5-4A20-9C60-8939EBD87E83 in Administering Oracle
GoldenGate. When you use a wildcard for the schema name you can override the
implicitly excluded schemas by explicitly listing the schema names.
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To map tables or wildcards you can click the Automap button and any unmapped
target table is mapped to a source table if the table names are the same regardless if
they are in different schemas. Alternatively, in the mapping editor you can drag and
drop source and target table names on each other to create the association.

Once tables are mapped you see the Source table name in the Target column
Mapped From. Only the Source table names are listed in this column but a tool tip
provides the source schema name. Double-click the Target table name or Mapped
From table name takes you to the column mapping editor.

To use a pluggable database, first specify pluggable database name and then schema
name in the following format <PDB>.<SCHEMA>. To use the replicat process from one
pluggable database to another, you have to edit the sourcecatalog parameter in the
Properties Inspector for the extract and replicat process. To use the replicat process
for multiple pluggable databases, you have to edit the mapping editor schema to add
the plugabble database name for the replication process.

Oracle Data Pump replication are usually done through databases, tablespaces,
schema and table types. Currently, only table type is supported. It requires both, the
schema name from a source and a target as well as the table name.

In the schema and table mapping editor you can define properties and logic for the
entire mapping, source tables, and target tables. The following figure and the table
shows the properties that can be edited based on where you click in the mapping
editor.

Note:

Wildcard mapping are not supported with Oracle Data Pump. No errors are
shown during deployment but the data on target side are not loaded.

Figure 4-1    Schema and Table Mapping

ID UI Element Properties

1 Map Breadcrumbs Name and description, DDL replication, global column
matching, DML conversions, and global replication error
responses.
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ID UI Element Properties

2 Source schema name Database name, schema name, and exclude schema from
source capture. The exclude schema is used when you have
used a wildcard for all schemas but want to explicitly exclude
certain schemas that would otherwise be included with the
wildcard.

3 Source table name Table name, exclude table from source capture, filter, Where
clause, custom SQL execution, event actions, and additional
custom properties. The table name cannot exceed 128
characters.

4 Target schema name Target schema name and exclude schema from target apply.

5 Target table name and
Mapped From

Target schema name and exclude table from target apply,
exception handling, filter, DML conversion, Where clause,
table specific replication error responses, custom SQL
execution, coordinated apply thread (if applicable),
coordinated apply thread range (if applicable), event actions,
more settings, and additional custom properties.

The table name cannot exceed 128 characters.

When you exclude table on source side a tableexclude parameter is written on
source side but corresponding map statements are not be written to target side.
Similarly, when you exclude table on target side a mapexclude parameter is written on
target side , but corresponding table statements are not written to source side.

Note:

When you have more than one table mapped you need to drill into column
mapping and select the table name to edit all the properties except exclude
property. This allows you to apply different logic to different tables.

4.1.2 Column Mapping

You can navigate to the column mapping from the table mapping editor. Double-click
the Target table name or the Mapped From column, or right-click anywhere on the
target row that contains the table name and chose Edit Column Mapping from the
context menu.

The Oracle GoldenGate runtime engine automatically maps matching column names
so, column mapping is not required. Column mapping works in the same way as table
mapping and you can use Automap and drag-and-drop between Source and Target.

In the column mapping editor, you can define the properties and logic for the Source
and Target tables and columns. The following figure and the table show the properties
that can be edited based on where you click in the mapping editor. It also shows how
to select individual table mappings when more than one table is mapped to a target
table and how to navigate back to the schema and table mapping editor.
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Note:

Selecting the table name in the column mapping editor provides the same
options as clicking the table name in the schema and table mapping editor
when there is only one source table mapped to the target table.

Figure 4-2    Column Mapping

ID UI Elements Properties

1 Map Breadcrumbs
showing mapping group
name

Select here to return to the schema and table mapping
editor.

2 Map Breadcrumbs
showing table mapping
name

If there is more than one source table mapped to this target
table, selecting here provides a drop-down list of those other
mappings and you can navigate to them.

3 Source table name Table name, exclude table from source capture, filter,
Where clause, custom SQL execution, event actions, and
additional custom properties.

4 Source column name Column name, exclude column from source capture, force
column to be used as (part of) the primary key.

5 Target table name Target table name, exclude table mapping from target apply,
force specific columns to be used as the key, exception
handling, conflict detection, conflict resolution, filter, DML
conversion, Where clause, table specific replication error
responses, custom SQL execution, coordinated apply
thread (if applicable), coordinated apply thread range (if
applicable), event actions, more settings, and additional
custom properties.

6 Target column name and
Mapped From

Column name, mapped from (which can contain source
column names or custom logic), force column to be used as
(part of) the primary key, enable this column for update
conflict detection, and enable this column for delete conflict
detection.
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Note:

Primary key column overrides, conflict detection, and conflict resolution are
only present in the column mapping editor.

4.1.3 Automap
The Automap feature automatically maps similarly named tables. Automapping
assignments are created from the source to target and not the reverse. Automapping
is not possible if the table structures are identical and the table names are different.

The mapping window looks as follows:

Figure 4-3    Automap

s

4.2 Creating a Mapping Group
To create a new local or global mapping group:

1. To create a mapping group that is local to the solution, select the Mapping Groups
under that solution and right-click to select New. To create a global mapping
group, right-click and select Global Mapping Group in the Resources Navigator.
If the Resources Navigator has no global mapping groups then click the plus icon
+ in the Resources Navigator, select Global Resource Library, and then select
Global Mapping Group.

The Create New Mapping Group or New Global Mapping Group window opens.

2. Provide a name and optional description for the Mapping Group, and click OK.

3. If the mapping editor window does not open automatically, double-click the new
mapping group in the Projects Navigator or Resources Navigator.

4. Add tables from the Global Resource Library by dragging and dropping them from
the library into the source and target panes of the mapping editor.

To select a list of tables you can use Shift-click on the first and last table in the set,
use Control-click to select multiple individual tables, or use the + button in the
source and target mapping editor panes to manually add schema and table
names. In the column mapping editor the equivalent + button allows you to add
columns manually.
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5. Drag and drop the table or schema names from either the Source or Target pane
to the other pane to create a source or target table mapping. If you drag the tables
to a white area it does an exact 1:1 mapping. If you drag a table name from one
pane to the other and drop it directly on the other table name, it creates an explicit
mapping.

For example, if table EMP1 in Source is to be mapped with EMP_BACK1 in Target,
then drag EMP1 from Source and drop it on EMP_BACK1 at Target. Typically, the
Mapped From field shows the Source table that is mapped with the target table. In
this case the Mapped From field has EMP1 value against the target table
EMP_BACK1.

You can also use the keyboard to perform the same action. When a source or
target schema does not have a reference to any specific Resources Navigator
schema and the name matches a particular database name in the Resources
Navigator, a confirmation dialog is displayed to associate the resource. You can
select Yes to complete the mapping.

If you select a table as target in the Mapping Editor, which is not mapped, the
Properties Inspector displays a Mapped From text box. You can enter the source
table name which is validated against a valid source table references and can be
mapped to target table if the source table is valid.

6. You can also use the AutoMap button to automatically create mappings for table
names that are the same between Source and Target. Source tables can be
mapped to more than one Target table and more than one Source table can be
mapped to a single Target table.

4.3 Assigning Mapping Groups to a Replication Path
Mapping group is assigned in the solution editor. To assign a local or global mapping
group to a replication path, drag the mapping group from the Projects Navigator or
Global Resource Library and drop on the replication path or data server in the solution
editor. If dropped onto a data server, the mapping group is automatically associated
with every replication path connecting that data server. If dropped on the replication
path arrow, the association is only for that path. You can drag the same mapping
group and drop on multiple paths and data servers. These associations are by
reference and not copies. Any change to the mapping group is automatically reflected
in every replication patch associated with that mapping group.

To remove a mapping group from a replication path, select the replication path in the
solution editor and in the Properties Inspector you see a list of all replication path
mapping associations. Select the desired mapping group name and click the red X
icon to delete. A confirmation dialog appears.

In the Properties Inspector of the replication path, there is a green + icon, which
provides an alternative way to add an association between a mapping group and
replication path. When you select the + icon, through a dialog box, you can add the
association for local and global mappings to this replication path.

4.4 Copying And Sharing Mapping Groups
When you right-click a local solution mapping group you can see options to copy it to
the Global Resource Library, make a copy (duplicate) of the selection within the same
solution. You can right-click the global mapping group and export to an XML file that
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can be imported by other Oracle GoldenGate users outside of your shared
environment. The export map dialog supports character set and encryption settings.

You can import both local and global exported mapping groups by using the right-click
option and select the appropriate Mapping Groups node in the Projects Navigator and
selecting Import.

The different Import Types are:

• Duplication: This mode creates a new object (with a new internal ID).

• Synonym Mode INSERT: This mode tries to insert the same object (with the same
internal ID).

• Synonym Mode UPDATE: This mode tries to modify the same object (with the same
internal ID).

• Synonym Mode INSERT_UPDATE: If no object exists in the target Repository with an
identical ID, this import mode will create a new object with the content of the
export file. Already existing objects (with an identical ID) will be updated.
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5
Deploying and Monitoring Your Solutions

Learn how to deploy and monitor your solutions either in Online of Offline mode in
Oracle GoldenGate Studio. You can also edit any information regarding the
deployment.
Topics:

5.1 Deploying Solutions
You can select to deploy your solution either in Online of Offline mode in Oracle
GoldenGate Studio.

• Online Deploy: Online deployments require that the Oracle GoldenGate instances
that are associated in the deployment profile have the manager, Oracle
GoldenGate Monitor jAgent, and the performance metrics server starting from the
Oracle GoldenGate 12.3 release onwards) is installed and running.

• Offline Deploy: Oracle GoldenGate Studio generates the Oracle GoldenGate
replication parameter and obey files and saves them in a local directory.

The online deployment implicitly runs a validation check by pinging the Oracle
GoldenGate instances that have been assigned as resources in the deployment profile
and ensures that the minimum required parameters have been set for those data
server types. Any parameter that is set and not related to the data server type to which
you are deploying is ignored when generating the parameter and obey files.

You can also explicitly run a validation by selecting the green check mark icon in the
deployment profile toolbar.

Before you write the configuration and command files, the jAgent backs up any files it
is about to overwrite to the dirtmp directory of the Oracle GoldenGate instance. Any
conflicting process is stopped. If you did not deselect the start option in the
Deployment Configuration options, then the process is started once the new
configuration files are created.

Once a deployment profile has been deployed you can view the deployment history
and some monitoring metrics in the Overview tab under Deployment Profile next to
the Deployment View tab. Deployment Configuration options can also be found in the
Overview tab under Deployment Profile. Those options include starting all Oracle
GoldenGate processes and performing full initial loads. Currently, partial initial loads
are not supported.

You can enter the non-default location for Parameter file and Report file under the Add
group of the Properties Inspector. By default (in both online as well as offline
deployments), all the parameter files and report files get generated under the dirprm/
dirrpt folder. If you want to deploy the parameter file or generate the report file in a
non-default location, then enter values in the Parameter File and Report File text
boxes of the Properties Inspector.
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Note:

Ensure that the alternate report file location is pre-created with full privileges,
so that Oracle GoldenGate Studio can deploy the process and generate
report file without any issue.

These values are considered only for a first-time deployment.

5.1.1 Deploying a Solution
A solution can be deployed in several ways as follows:

1. Through the Deployment Profile Toolbar.

2. Through the context menu in the Deployment Profile editor.

3. Through the Projects Navigator Deployment Profile Node.

For example, to deploy a solution through the Projects Navigator:

1. In the Projects Navigator, select the Deployment Profile that you want to deploy
and right-click to select Deploy.

2. Select between Deploy or Generate GoldenGate Files. Deploy is used for online
deployment while the files generated by Oracle GoldenGate are used for offline
deployment.

3. Follow the on screen instructions to continue with deployment.

For offline deployment, you can select a directory to save the deployment files.

5.1.2 Viewing Report Files and GGSERR.LOG Files
After the successful online deployment, the user can view the report file of the
deployed process as well as Oracle GoldenGate error log file (ggserr.log) in the
Oracle GoldenGate Studio interface.

• To view the report file, select the process in the Deployment View, right click, and
then select the View Report File to display the report file. You can also download
the report file.

• If you want to view the error log, then select the Oracle GoldenGate Instance
component in the Deployment View, right click and select the View GoldenGate
Error Log.

5.2 Overview
This tab is used to edit information regarding the name and description of the
deployment profile, deployment history, and deployment configuration.

5.2.1 Definition
Use this tab to edit high level details of the deployment profile. The available fields are:

• Deployment Profile Name: You can view and edit the name of the deployment
profile.
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• Description: You can add or edit the description of the deployment profile.

5.2.2 Deployment History
It provides a historical record of past deployments for a project, solution, deployment,
or a single deployment profile.You can use the Select Columns icon in the table's
toolbar to tailor your view of the deployment history information. Columns can be re-
ordered as per requirement.

The available columns are:

• Last Deployed

• Deployment Status

• Deployed By

• Comments

• Process Name

• Process Type

• Instance Name

5.2.3 Monitoring

Details information about the status of every process under Monitoring. Additionally,
you can monitor the status of each process that is currently deployed on an Oracle
GoldenGate instance, such as the status, type, and mode of processes.

The tab looks as follows:

Figure 5-1    Monitoring Tab

The available columns are:

• Status

• Process Name

• Type

• Last Operation Lag

• Mode

• last Operation Timestamp

• last Checkpoint Timestamp

• Total Inserts
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• Total Deletes

• Total Updates

• Working Directory

• Start Time

• End of File

• Total Ignores

• Total Truncates

• Total Executed DDLs

• Total Discards

• Total Operations

• Input Checkpoint

• Output Checkpoint

Note:

The Monitoring tab displays information of whether or not the deployment
process has successfully begun. If the deployment commands were
successfully fired from Oracle GoldenGate Studio, then the Deployment
process is also successful.

5.2.4 Deployment Configuration
Use this tab to view or edit the deployment options and physical resources.

You use the Deployment Settings check boxes to control the processes that must start
automatically. The following settings can be configured:

Deployment Settings

• Start All GoldenGate Processes: Select this check box to start the Capture, Pump,
and Apply processes.

• Start Pump Processes: Select this check box to start the Pump processes.

• Start Apply Processes: Select this check box to start the Apply processes.

Initial Load Settings

• Oracle GoldenGate: Select this check box to start the Oracle GoldenGate initial
load process.

• Oracle Data Pump: Select this check box to start the Oracle Data Pump initial load
process.

If you select the Start process in deployment configuration screen, then the
Change Data Capture (CDC) process starts automatically at the successful
completion of Initial Load Deployment. If you do not select the Start process in
deployment configuration screen, then the CDC process doesn't start
automatically.
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If Oracle GoldenGate Studio is closed before the automatic start of CDC process,
then the CDC process will not start automatically. You can start the CDC process
manually using System Change Number (SCN), or starting the CDC process
manually from the monitoring screen. The SCN increments by one with every
commit.

You can add the Remote Link (network link) and Parallelism in this dialog. By
default, parallelism is set to one.

5.2.5 Oracle Data Pump
Oracle GoldenGate Studio uses the Oracle Data Pump API for the initial load. Oracle
Data Pump API can transfer data using different methods. In Oracle GoldenGate
Studio, the IMPORT of data using flashback SCN is used. The Remote Link (network
link) is used to access the source Database.

During Online Deployment with Oracle Data Pump Initial Load ,Oracle GoldenGate
Studio starts a PL/SQL procedure in the target database. This PL/SQL block invokes
Oracle Data Pump job, providing it with Database Link to copy the data from source,
SCN of source database, number of parallel threads to be launched, and log filename
to log its activity. You have to provide the Database Link and Parallel values in the
configuration screen while SCN of source database and log file name are provided by
Oracle GoldenGate Studio. Oracle GoldenGate Studio also assumes DATA_PUMP_DIR
directory to be created in target database, as this directory is used to create the log
file. Oracle Data Pump table shows the current state of the Oracle Data Pump job. You
can click on View Activity Log to view the content of the ODP Job OGG_LOG log file.

Note:

You can only use the default trail file directory dirdat. User defined trail file
directories are not supported in Oracle GoldenGate Studio and are not
parsed.

In parallel , CDC captures and replicat processes are deployed inOracle GoldenGate.
The capture processes are started to capture the online transactions while Oracle
Data Pump is progressing. Oracle GoldenGate Studio waits for Oracle Data Pump job
to complete. After completion of the Oracle Data Pump job, if Start Replicat option
was selected, Oracle GoldenGate Studio starts the replicat processes with the related
SCN number shown in the Oracle Data Pump page of the particular process. If not,
you have to manually start the process by clicking on Start CDC Replicat in the
Oracle Data Pump window.

If you shut down Oracle GoldenGate Studio after completion of Deployment in Oracle
GoldenGate but before Oracle Data Pump job is complete, you have to manually starts
the Replicat by clicking on Start CDC Replicat in the Oracle Data Pump page or Start
with.. using the SCN shown in Oracle Data Pump page.

You can select the Replication Paths from the drop-down list and the status as Not
Started, Running, Error, Finished, and Replicat Started. The status is displayed in
tabular format. You can also use the toolbar to search, start the CDC Replicat, view
the activity log, refresh table, and add or remove additional table columns.

The following table columns are displayed by default:
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• Replication Paths

• Start Time

• End Time

• SCN

• Status

• % Complete

• Time Remaining

The Time Remaining column can be empty when Oracle Data Pump is running. This
is not related to the normal functioning of the product.

The Oracle Data Pump window looks as follows:

Chapter 5
Overview

5-6



6
Managing Security

Learn how to manage the security for your replications by using Oracle GoldenGate
Studio. Security manager allows you to create users, manage passwords and manage
the security in Oracle GoldenGate Studio.
Topics:

6.1 Understanding Security in Oracle GoldenGate Studio
The Security Navigator to manage the Security in Oracle GoldenGate Studio. You can
also use the Security Navigator to create users, manage password, and to set an
account expiration date. Users in Oracle GoldenGate Studio can be Supervisor, or
Administrator and non supervisors. There can be only one SUPERVISOR account that is
created using RCU. Non supervisor users cannot access the Security Navigator
window.

The Security Navigator looks as follows:

Figure 6-1    Security Navigator

6.2 Using the Security Navigator
The Security Navigator is available only for user with SUPERVISOR privilege which is
the account created during repository creation. Non supervisor accounts can only
change their own password using Change Password menu option under OGG menu.

You can do the following tasks by using the Security Navigator:

• Adding a New User.

• Modifying an Existing User.
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• Deleting an User.

6.2.1 Adding a New User
To add a new user, do as follows:

1. Click the user button and select New User.

2. Click Change Password, type the New Password, type the same password in
Confirm Password. You can also set the Allow Expiration Date to set a
password expiration date (optional). If this is set, the user needs to change the
password in the log in after the expiry date.

3. Click the Save button in the toolbar.

The change password dialog looks like:

Figure 6-2    Change Password Dialog

Note:

You can set the Allow Expiration Date option in the Account Expiration
option to prevent the user from using the product after the expiry date. This is
different from the Allow Expiration Date option in the Change User
Password option dialog.

Note:

If you set the expiry date for the SUPERVISOR user an it expired, the
SUPERVISOR user account cannot be enabled again.

6.2.2 Modifying an Existing User

To modify an existing user, do as follows:
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1. Right-click on the user and select Open.

2. Modify the user name under Name.

3. Click the Change Password, type the new password and expiration date
(optional).

4. Click the Save button in the toolbar.

Note:

This option is available only for users with SUPERVISOR privilege. It is
identified by a red icon. Non-supervisor users are identified with a green
icon.

6.2.3 Deleting an User
To delete an existing user, do as follows:

1. Highlight the user, right-click and select Delete.

2. In the confirmation dialog box, click Yes.

Note:

The user with supervisor privilege can delete any user with non supervisor
privilege. SUPERVISOR account cannot be deleted.

6.3 Deleting a Secure Wallet
You cannot change the password for a secure wallet. If you need to reset a wallet
password, you have to delete the wallet then recreate it as follows:

1. Close Oracle GoldenGate Studio.

2. Go to the cache directory in your Oracle GoldenGate Studio instance. The default
directories are:

• Windows: —  C:\Users\username\AppData\Roaming\oggstudio\oracledi
\ewallet

• UNIX and Linux: — ~/.oggstudio/oracledi/ewallet 

3. Delete the wallet file. For example, ewallet.p12.

4. Create the wallet again.
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7
Troubleshooting

Here are solutions to some of the common issues that may come across while using
Oracle GoldenGate Studio.
Topics:

7.1 Positioning of Docked Windows
Issue: Multiple docked windows like Projects Navigator, Component pallets, and so on
are misplaced and do not fit the main application window properly.

Solution: Navigate to the Window menu and click Reset Windows To factory
Settings.

7.2 Performance Issues While Using Oracle GoldenGate
Studio

Issue: Severe performance issue when you use Oracle GoldenGate Studio.

Solution: Ensure that the repository is installed in the same LAN.

7.3 Privilege Issue with Oracle GoldenGate Studio
Issue: Only SUPERVISOR user have object level privilege.

Solution: To prevent contention against the same set of objects, it is recommended
that Projects and Solutions are well planned in terms of who is working on the same
objects.

7.4 Syntax Errors with Generated Code
Issue: Syntax errors are present.

Solution: Check the version and database values of the data servers assigned to the
deployment profiles generated Code is compatible with the assigned data servers.

Next, check to see if the code can be successfully parsed by the Oracle GoldenGate
Core product. If the syntax is successfully parsed by that tool, then the Oracle
GoldenGate Studio and Core files are compatible.

If it is not successfully parsed and the error is not in the mapping syntax, then you can
contact Oracle Support.

7.5 Not Able to Add Resources
Issue: Not able to set add resources by using the drag-and-drop option.
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Solution: Ensure that you are dropping the resources to correct targets and to the
solution editor links instead of Mapping Group to Deployment Profile links. You can
add physical resources only to the Deployment Profile view. The Big Data System
and Teradata are target only databases. You can drag-and-drop target only databases
as a source database in the mapping editor. This is possible as mapping is a logical
concept and no check is performed by Oracle GoldenGate Studio.
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A
Concepts and Terminology

Understand the concepts and terms associated with Oracle GoldenGate Studio.

Term Description

Apply An Oracle GoldenGate process that writes the changes captured in a
trail file to a target data server.

AutoMap Functionality that makes mapping recommendations based on pattern
matching of schema, table and column names, and data types.

Bidirectional Name of a solution template that has a single source and single target
with replication paths in both directions.

Business Entity Logical representation of data that records a business or agency
activity, usually regarding the sale, distribution, or development of a
product or a service.

Capture An Oracle GoldenGate process that writes records relating to change
data from a source system (database or JMS queue) into binary files
(trails).

CDR Conflict Detection and Resolution. A specific use case of error detection
and response logic found typically in bidirectional and Active-Active
solutions.

Column Mapping The mapping of columns and fields between two tables or other data
entities.

Conflict Detection A specific use case of error detection.

Conflict Resolution A specific use case of error response.

Connections Information used to attach to a data server or Oracle GoldenGate
instance.

Consolidation Name of a solution template where many sources map to a single
target.

Credential Store The Oracle GoldenGate credential store manages user IDs and their
encrypted passwords (together known as credentials) that are used by
Oracle GoldenGate processes to interact with a database.

Data Entity Typically a table but any data object that can be replicated including a
sequence but not replicated logic such as procedures.

Data Server Most commonly a database but can be any external (to GoldenGate)
source or target of data (for example JMS). They contain information
about data entities that are replicated (for example tables) as well as
procedural logic that affect data for example triggers and procedures).
Can be used as a source or target.

Data server login
credentials

Username and password to access data server.

DDL Data definition language statements that can be replicated between
similar databases.

Deployment Physical architecture bound to a logical design that contains one or
more profiles.

A-1



Term Description

Deployment Assistant A sequence of dialog boxes that leads the user through creating a
physical deployment, then allows the user to assign GoldenGate
instances to the replication paths, and provides additional deployment
options such as perform initial load.

Deployment History Contains a historical manifest of deployments and can be viewed in the
context of a project, solution, deployment, or a single deployment
profile.

Deployment Profile The physical architecture plus the physical properties of specific
processes (their names, behavior options, environmental settings) It
contains the details that binds the logical design to the physical
architecture.

Deployment Template The physical relationship of data servers, GoldenGate instances, and
hosts.

Description Text field that contains the name and description for a Project, Solution,
or Deployment.

Distribution Name of a solution template that has a single source and multiple
targets.

Document Tab Tabs along the top of the interface that display solutions, library
mappings, and library logic.

Editor Tab Tab located at the bottom of the interface that is subordinate to the
Document Tab.

Exception Mapping One or more auxiliary mappings that are invoked only when the primary
mapping encounters an error.

Filter Component of mapping to define rules to omit rows.

Folder An interface construct used to select and visually organize related
objects such as, mappings, logic, and connections.

Functions Oracle GoldenGate built-in logic constructs that can act on change data
or metadata resulting in the transformation, inclusion, or exclusion of
column data. Used in the expression editor.

Oracle GoldenGate
Agent

Heavy weight agent designed to monitor Oracle GoldenGate instances
with minimal management capabilities.

Oracle GoldenGate
Gallery

A sequence of dialog boxes that leads the user through creating new
Oracle GoldenGate Studio Projects, Solutions, Deployments, and
Connections.

Oracle GoldenGate
Instances

The connection details for an Oracle GoldenGate Instance available in
the Resources Navigator.

Oracle GoldenGate
processes

Processes and services that are part of the GoldenGate instance used
for capturing, transferring, modifying, and applying data.

Hub and Spoke Name of a solution template. Distributed data model consisting of
connections arranged like a wheel, in which all traffic moves along the
spokes connected to the hub at the center.

Initial Load The copying of data between systems before changes to that data are
applied.

Library A collection of shared mappings or logic code that can be used in more
than one solution or project.

Logic library Logic code used in mapping and error handling that can be used in
more than one solution or project.

Logical Design One or more data servers with connected replication paths.
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Term Description

Mapping Library A collection of maps that can be used in more than one solution or
project.

Mapping/Map The assignment of one or more data entities to another or one or more
statements to a data server.

Mappings First-level construct containing the mapping of data entities,
statements, and the associated logic that is not shared beyond the local
solution.

Overview Name of an editor level tab under solution that provides high-level
details of the solution as well as control over the access privileges.

Parameters The set of all configurable items relating to the runtime behavior of
Oracle GoldenGate processes used in replicating and loading data.
Broken down into several areas, the most significant relating to the
mapping logic.

Project The highest level object that contains Oracle GoldenGate solutions.

Project Wizard A sequence of dialog boxes that leads the user through creating a new
project.

Projects Navigator The interface used to select Oracle GoldenGate Studio projects.

Properties Inspector Shows attributes of selected artifacts and provide a means to change,
add, or remove those attributes.

Replication Path The path denoting one direction of change data as it moves between
data servers. Two data servers can have from zero to two direct
replication path connections, but only one path in each direction.

Replication Source Data server from which data is read, copied, and transmitted.

Resource Data Server and Oracle GoldenGate connections and mapping library.

Resource Assignment The act of assigning physical resources.

Resources Navigator Interface used to select Oracle GoldenGate Studio resources.

Schema Mapping The mapping of schemas and tables.

Security Navigator The interface used to select Oracle GoldenGate Studio security
options.

Solution A deployable object that represents a replication design. The design
view describes data servers, replication paths, mappings, and a logical
design. The deployment profile describes the resource assignments
involved in the physical design. Solutions can contain more than one
deployment profile. A single solution design can be deployed to any
number of physical systems by creating a deployment profile for each
physical system.

Solution Wizard A sequence of dialog boxes that leads the user through creating a new
solution by providing a menu of common solution templates, and then
allows the user to add existing mappings, bind data server connections
to the logical design, and finally include mappings from the mapping
library.

Solution Navigator The interface used to select Oracle GoldenGate Studio solutions,
mappings, logic, and deployments.

Solution Templates Preconfigured solution templates are provided.

Structure Panel Auxiliary navigator to show any additional details beyond what higher
level navigators allow.

Target Data server to where data is written.
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Term Description

Trail Sequenced set of binary files used to queue and read captured
transactions by Oracle GoldenGate.

Unidirectional Name of a solution template that has a source replicating a target.

Wallet Digital Oracle wallet used to store encryption keys, this is managed and
used by the Oracle GoldenGate processes to encrypt and decrypt data
at rest and in flight.
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B
Oracle GoldenGate Commands and
Parameters that you can use with the
Properties Inspector

Learn about the correlation between the Oracle GoldenGate commands and
parameters that are run when you select the various options in the Properties
Inspector.
See Oracle GoldenGate Commands and Oracle GoldenGate Parameter .

Note:

Deprecated Oracle GoldenGate parameters are not displayed or supported
in Oracle GoldenGate Studio. You can review deprecated parameters in 
Release Notes for Oracle GoldenGate

B.1 Commands with Options
The Oracle GoldenGate commands with the specified options are listed in the
following sections.

B.1.1 ADD EXTRACT Commands
For an explanation of the command, see the ADD EXTRACT command.

ADD EXTRACT Command Oracle GoldenGate Studio Label

ADD EXTRACT 
Add Extract

SOURCEISTABLE 
Table

TRANLOG 
Transaction Log

INTEGRATED TRANLOG 
Integrated Capture Mode

VAM 
Vendor Access Module

EXTFILESOURCE 
Source File Name

EXTTRAILSOURCE 
Source Trail Name
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ADD EXTRACT Command Oracle GoldenGate Studio Label

VAMTRAILSOURCE 
VAM Trail Name

BEGINNOW 
Now

EXTSEQNO 
At Sequence Number

EXTRBA 
Relative Byte Address

EOF 
End of Log File

LSN 
LSN

EXTRBA 
Relative Byte Address

PAGE 
Page

ROw
ROW

SEQNO 
Sequence Number

SCN 
System Change Number

THREADS 
Threads

PASSIVE 
Passive

PARAMS 
Parameter File

REPORT 
Report File

DESC 
Description

B.1.2 ADD REPLICAT Commands
For an explanation of the command, see the ADD REPLICAT command.

ADD REPLICAT Options Oracle GoldenGate Studio Label

ADD REPLICAT 
Add Replicat

INTEGRATED 
Integrated
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ADD REPLICAT Options Oracle GoldenGate Studio Label

COORDINATED
Coordinated

MAXTHREADS
Max Threads

SPECIALRUN 
Special Run

EXTFILE 
Extract File

EXTTRAIL 
Extract Trail

BEGIN 
Begin

NOW 
Now

EXTSEQNO 
Sequence Number

EXTRBA
Relative Byte Address

CHECKPOINTTABLE 
Checkpoint Table

NODBCHECKPOINT 
No Checkpoint Table

PARAMS 
Parameter File

REPORT 
Report File

DESC 
Description

B.1.3 ADD EXTTRAIL Command
For an explanation of the command, see the ADD EXTRAIL command.

ADD EXTTRAIL Options Oracle GoldenGate Studio Label

ADD EXT TRAIL 
Add Extract Trail

EXTRACT 
Extract

MEGABYTES 
Megabytes

SEQNO 
Sequence Number
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B.1.4 ADD RMTTRAIL Command
For an explanation of the command, see the ADD RMTTRAIL command.

ADD RMTTRAIL Options Oracle GoldenGate Studio Label

ADD RMTTRAIL 
Add Remote Trail

EXTRACT 
Extract

MEGABYTES 
Megabytes

SEQNO 
Sequence Number

B.1.5 REGISTER EXTRACT Command
For an explanation of the command, see the REGISTER EXTRACT command.

REGISTER EXTRACT Options Oracle GoldenGate Studio Label

REGISTER EXTRACT 
Register Extract

DATABASE 
Database

CONTAINER 
Container

ADD CONTAINER 
Add Container

DROP CONTAINER 
Drop Container

LOGRETENTION 
Log Retention

SCN 
System Change Number

B.1.6 START EXTRACT Command
For an explanation of the command, see the START EXTRACT command.

Start Extract Command Oracle GoldenGate Studio Label

START EXTRACT 
Start Extract

ATCSN 
At CSN
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Start Extract Command Oracle GoldenGate Studio Label

AFTERCSN 
After CSN

B.1.7 START REPLICAT Command
For an explanation of the command, see the START REPLICAT command.

Start Replicat Command Oracle GoldenGate Studio Label

START REPLICAT 
Start Replicat

SKIPTRANSACTION 
Skip Transaction

ATCSN
At CSN

AFTERCSN
After CSN

FILTERDUPTRANSACTIONS 
Filter Duplicate Transactions

THREADS 
Threads

B.1.8 ADD TRANDATA Command
For an explanation of the command, see the ADD TRANDATA command.

Add Supplemental Logging Command Oracle GoldenGate Studio Label

ADD SCHEMATRANDATA
Enable Schema Supplemental Logging

ALLCOLS 
Logging Columns

ALLOWNONVALIDATEDKEYS
Allow Non-Validated Keys

ADD TRANDATA 
Enable Table Supplemental Logging

COLS 
Logging Columns

NOKEY 
Suppress Primary Key Columns

INCLUDELONG 
Include LONGVAR Columns

EXCLUDELONG 
Exclude LONGVAR columns
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B.2 Parameter Category Names
This section lists the parameter category names available for Oracle GoldenGate
Studio.

• Add Extract Options

• Add Replicat Options

• Extract Registration

• Globals

• General

• Environment Variables

• Include

• Port Management

• Process Management

• Event Management

• Maintenance

• Processing Method

• Selection, Converting, and Mapping Data

• Routing Data

• Formatting Data

• Custom Processing

• Reporting

• Tuning

• Error Handling

• Rep Error

• Security

• Other

• Advanced

• Start Extract Options

• Start Replicat Options

• Supplemental Logging

For more information on parameter categories, see Oracle GoldenGate Parameters.

B.3 Units of Measure
This section describes the units of measure available for Oracle GoldenGate Studio.
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Unit Option

MS 
Millisecond

CS 
Centisecond

CSEC 
Centisecond

CSECS 
Centiseconds

S 
Second

SEC 
Second

SECOND 
Second

SECS 
Seconds

SECONDS 
Seconds

M 
Minute

MIN 
Minute

MINUTE 
Minute

MINS 
Minutes

MINUTES 
Minutes

H 
Hour

HR 
Hour

HOUR 
Hour

HOURS 
Hours

D 
Day

DAY 
Day

DAYS 
Days
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Unit Option

WEEK 
Week

WEEKS 
Weeks

K 
Kilobyte

KB 
Kilobyte

MB 
Megabyte

G 
Gigabyte

GB 
Gigabyte

B.4 Opposites
This section describes the opposites between Oracle GoldenGate parameters or
options and Oracle GoldenGate Studio labels.

Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

batchsql.nobatcherrormode 
No Batch Error Mode

batchsql.nobypasspkcheck 
Do not Bypass PK Check

batchsql.nocheckuniquekeys 
Do not Check Unique Keys

batchsql.noerrorhandling 
No Error Handling

bulkload.nologging 
Disable Redo Logging

bulkload.noparallel 
Disable Parallel Loading

dboptions.noallowlobdatatruncate 
Disallow LOB Truncation

dboptions.noallowunusedcolumn 
Disallow Unused Columns

dboptions.nocatalogconnect 
No Separate Catalog Connection

dboptions.nofetchlobs 
Disallow LOB Fetching

dboptions.nolimitrows 
Do not Limit Rows
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

dboptions.noreparselobsql 
Do not Reparse LOB SQL

dboptions.noshowwarnings 
Do not Log Warnings

dboptions.noskiptemplob 
Do not Skip Temp LOB

dboptions.nospthread 
No Separate Connection For Stored
Procedures

dboptions.nosuppresstriggers 
Do not Suppress Triggers

ddloptions.CROSSRENAME 
Cross Rename

ddloptions.ignoreapplops 
Ignore Application Operations

ddloptions.ignorereplicates 
Ignore Replicat Transactions

ddloptions.nomapderived 
Disallow Derived Name Mapping

ddloptions.noreplicatepassword 
Do not Replicate Password

ddloptions.noreport 
Do not Log DDL Operations To Report File

disableheartbeat 
Disable Heartbeat

disableheartbeattable 
Disable Heartbeat Table

disablenewmanager 
Disable New Manager

extfile.no_objectdefs 
No Object Definitions

exttrail.no_objectdefs 
No Object Definitions

fetchoptions.nodetaileddiagnostics 
No Detailed Diagnostics

fetchoptions.nodiagnosticsonall 
No Diagnostics On All

fetchoptions.nousediagnostics 
Do not Use Diagnostics

fetchoptions.nousekey 
Do not Use Key

fetchoptions.nouselatestversion 
Do not Use Latest Version
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

fetchoptions.nouserowid 
Do not Use Row ID

fetchoptions.nousesnapshot 
Do not Use Snapshot

fetchoptions.suppressduplicates 
Suppress Duplicates

formatascii._noind 
No Ind

formatascii._noop 
No Op

formatascii._nots 
No TS

formatascii.nonames 
Exclude Column Names

formatxml.noinlineproperties 
Write Properties Outside XML Tab

formatxml.notrans 
Exclude Commit Markers

ignorealters 
Ignore Alters

ignoreapplops 
Ignore Application Operations

ignorecreates 
Ignore Creates

ignoredeletes 
Ignore Deletes

ignoredrops 
Ignore Drops

ignoreinserts 
Ignore Inserts

ignorereplicates 
Ignore Replicat Transactions

ignoretruncates 
Ignore Truncates

ignoreupdateafters 
Ignore Update After Images

ignoreupdatebefores 
Ignore Update Before Images

ignoreupdates 
Ignore Updates

map.nohandlecollisions 
Do not Handle Collisions
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

map.noinsertappend 
Do not Insert Append

map.noinsertmissingupdates 
Do not Insert Missing Updates

map.nomapinvisiblecolumns 
Do not Map Invisible Columns

map.notrimspaces 
Do not Trim CHAR to VARCHAR Trailing
Spaces

map.notrimvarspaces 
Do not Trim VARCHAR to CHAR Trailing
Spaces

no_use_traildefs 
Do not Use Trail Definitions

noallowduptargetmap 
Do not Allow Duplicate Target Map

noallowlargefloat 
Do not Allow Large Float

noallownoopupdates 
Do not Allow No-Operation Updates

noapplynoopupdates 
Do not Apply No-Operation Updates

noassumetargetdefs 
Do not Assume Target Definitions

noauditreps 
Do not Audit Replicats

nobinarychars 
Do not Use Binary Characters

nocachenullablecols 
Do not Cache Nullable Columns

nocharsetconversion 
Disable Character Set Conversion

nochecksequencevalue 
Do not Check Sequence Values

nocomplexnullcond 
No Complex Null Conditions

nocompressdeletes 
No Compress Deletes

nocompressupdates 
No Compress Updates

nodeletelogrecs 
Do not Delete Log Records

nodynamicresolution 
No Dynamic Resolution
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

nodynsql 
No Dynamic SQL

nofilterdups 
Do not Filter Duplicates

nohandlecollisions 
Do not Handle Collisions

noinsertappend 
No Insert Append

noinsertdeletes 
Do not Insert Deletes

noinsertmissingupdates 
Do not Convert Failed Updates To Inserts

noinsertupdates 
Do not Insert Updates

nolist 
Do not List Parameters in Report File

nologallsupcols 
Do not Capture All Supplementally Logged
Columns

nomapinvisiblecolumns 
Do not Map Invisible Columns

nooverridedups 
Do not Override Duplicates

nopassthru 
Disable PassThru

nopassthrumessages 
Disable PassThru Messages

norestartcollisions 
Don't Restart Collisions

nospacestonull 
Do not Convert Spaces to Null

notcpsourcetimer 
Do Not Compensate For System Clock
Differences

notrimspaces 
Do not Trim CHAR to VARCHAR Spaces

notrimvarspaces 
Do not Trim VARCHAR to CHAR Spaces

noupdatedeletes 
Do not Convert Deletes To Updates

noupdateinserts 
Do not Convert Inserts To Deletes

nouseansisqlquotes 
Do not Use ANSI SQL Quotes
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

nousededicatedcoordinationthread 
Do not Use Dedicated Coordination Thread

novarwidthnchar 
Do not Treat NCHAR, NVARCHAR2,
NCLOB As UTF-16

purgeoldextracts.no_use_checkpoints 
Do not Use Checkpoints

reportcount.norate 
Do not Report Rate

rmtfile.no_objectdefs 
No Object Definitions

rmttrail.no_objectdefs 
No Object Definitions

showsyntax.apply 
Apply

statoptions.noreportdetail 
No Operation Statistics

statoptions.noreportfetch 
Do not Fetch Statistics

statoptions.noresetreportstats 
Do not Reset Report Statistics

table.notrimspaces 
Do not Trim CHAR to VARCHAR Spaces

table.notrimvarspaces 
Do not Trim VARCHAR to CHAR Spaces

trail_seqlen_6d 
Trail Sequence Length 6 digits

tranlogoptions._noarchivedlogonly 
Do not Read Only From Archived Logs

tranlogoptions.ignoremetadatafromvam 
Ignore Metadata From VAM

tranlogoptions.noapifilter 
No API Filter

tranlogoptions.nocompletearchivedlogonly 
No Complete Archived Log

tranlogoptions.nogetctasdml 
Do not Get CTAS DML

tranlogoptions.nomanagesecondarytruncationpo
int 

Manage Secondary Truncation Point

tranlogoptions.nominefromactivedg 
Do not Mine From Active Data Guard

tranlogoptions.nominefromsnapshotstby 
Do not Mine From Standby Snapshots
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Oracle GoldenGate Parameters/Options Oracle GoldenGate Studio Label

tranlogoptions.noprepareforupgradetoie 
Do not Prepare For Upgrade To Integrated
Extract

tranlogoptions.nopurgeorphanedtransactions 
Do not Purge Orphaned Transactions

tranlogoptions.nousenativeobjsupport 
Do not Use Native Object Support

tranlogoptions.nouseprevresetlogsid 
Do not Use Previous Reset Log SID

tranlogoptions.nouserexit 
No User Exit

B.5 Other Oracle GoldenGate Parameters/Options
This section describes additional commands and parameter options for Oracle
GoldenGate Studio.

Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

a2e 
ASCII to EBCDIC

accessrule 
Access Rule

allocfiles 
Allocate Memory Structures

allowduptargetmap 
Allow Duplicate Target Map

allowinvisibleindexkeys 
Allow Invisible Index Keys

allowlargefloat 
Allow Large Float

allownonvalidatedkeys 
Allow Non-Validated Keys

allownoopupdates 
Allow No-Operation Updates

allowoutputdir 
Allow Output Directory

applynoopupdates 
Apply No-Operation Updates

asciimixedccsid 
ASCII Mixed CCSID

asciitoebcdic 
ASCII to EBCDIC

assumetargetdefs 
Assume Target Definitions
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

assumetargetdefs.override 
Override Target Defs

auditreps 
Audit Replicats

autorestart 
Auto Restart

autorestart.er 
Extract/Replicat

autorestart.extract 
Extract

autorestart.replicat 
Replicat

autorestart.resetminutes 
Reset Time (mins)

autorestart.retries 
Retries

autorestart.waitminutes 
Wait Time (mins)

autorestartinterval 
Auto Restart Interval

autorestartmintime 
Auto Restart Minimum Time

autostart 
AutoStart

autostart.er 
Extract/Replicat

autostart.extract 
Extract

autostart.replicat 
Replicat

batchsql 
BatchSQL

batchsql.batcherrormode 
Batch Error Mode

batchsql.batchesperqueue 
Batches Per Queue

batchsql.batchtransops 
Operations Per Transaction

batchsql.bypasspkcheck 
Bypass PK Check

batchsql.bytesperqueue 
Bytes Per Queue
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

batchsql.checkuniquekeys 
Check Unique Keys

batchsql.errorhandling 
Error Handling

batchsql.maxthreadqueuedepth 
Max Thread Queue Depth

batchsql.numthreads 
Number of Threads

batchsql.opsperbatch 
Operations Per Batch

batchsql.opsperqueue 
Operations Per Queue

batchsql.thread 
Thread

batchsql.trace 
Trace

begin 
Begin

binarychars 
Binary Characters

bootdelayminutes 
Boot Delay (min)

bootdelayseconds 
Boot Delay (secs)

br 
Bounded Recovery

br.brdir 
Directory

br.brfsoption 
FS Option

br.brinterval 
Interval

br.brkeepstalefiles 
Keep Stale Files

br.broff 
Off

br.broffonfailure 
Off On Failure

bulkload 
Bulk Load

bulkload.logging 
Log To Redo
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

bulkload.noskipallindexes 
Enable Index Maintenance

bulkload.parallel 
Enable Parallel Loading

bulkload.skipallindexes 
Skips Index Maintenance

bulkload.skipunusedindex 
Skip Unusable Indexes

cachemgr 
Cache Manager

cachemgr.cachebuffersize 
Cache Buffer Size

cachemgr.cachedirectory 
Cache Directory

cachemgr.cachefsoption 
Cache File Sync Option

cachemgr.cachepageoutsize 
Cache Page Outsize

cachemgr.cachesize 
Cache Size

cachenullablecols 
Cache Nullable Columns

catalogexclude 
Catalog Exclude

catalogexclude.norename 
No Rename

cdroptions 
CDR Options

cdroptions.applymodcolonly 
Apply Modified Columns Only

charmap 
Character Map Override

charset 
Parameter File Character Set

charsetconversion 
Enable Character Set Conversion

checkminutes 
Maintenance Check Minutes

checkparams 
Check Parameter Syntax

checkpointsecs 
Checkpoint Seconds
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

checkpointtable 
Checkpoint Table

checksequencevalue 
Check Sequence Values

cmdtrace 
Command Trace

colmatch 
Column Match

colmatch.names 
Names

colmatch.prefix 
Prefix

colmatch.reset 
Reset

colmatch.suffix 
Suffix

comment 
Comment

complexnullcond 
Complex Null Condition

compressdeletes 
Compress Deletes

compressdeletes.fetchmissingcolumns 
Fetch Missing Columns

compressupdates 
Compress Updates

coordstatinterval 
Coordinate Statistic Interval

coordtimer 
Coordinate Timer

credentialstorelocation 
Credential Store Location

cuserexit 
C User Exit

cuserexit.includeupdatebefores 
Include Update Before Images

cuserexit.params 
Params

cuserexit.passthru 
PassThru

dboptions 
Database Options
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

dboptions.allowlobdatatruncate 
Allow LOB Truncation

dboptions.allowunusedcolumn 
Allow Unused Columns

dboptions.bindcharforbitaschar 
Encode CCSID Data

dboptions.catalogconnect 
Use Separate Catalog Connection

dboptions.catalogur 
Catalog Uncommit Read

dboptions.connectionport 
Connection Port

dboptions.decryptpassword 
Decrypt Password

dboptions.decryptpassword.algorithm 
Algorithm

dboptions.decryptpassword.aes128 
AES128

dboptions.decryptpassword.aes192 
AES192

dboptions.decryptpassword.aes256 
AES256

dboptions.decryptpassword.blowfish 
Blowfish

dboptions.decryptpassword.encryptkey 
Encryption Key

dboptions.deferrefconst 
Defer Referential Integrity Constraint

dboptions.disablecommitnowait 
Disable Asynchronous Commits

dboptions.disablelobcaching 
Disable LOB Caching

dboptions.emptylobstring 
Empty LOB String

dboptions.enableinstantiationfiltering 
Enable InstantiationCSN Filtering

dboptions.fetchbatchsize 
Fetch Batch Size

dboptions.fetchcheckfreq 
Fetch Check Freq

dboptions.fetchlobs 
Fetch LOBs
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

dboptions.fetchretrycount 
Fetch Retry Count

dboptions.fetchtimeout 
Fetch Timeout

dboptions.host 
Host

dboptions.integratedparams 
Integrated Parameters

dboptions.integratedparams.ALLOW_DUPLICATE_R
OWS 

Allow Duplicate Rows

dboptions.integratedparams.APPLY_SEQUENCE_NE
XTVAL 

Apply Sequence Next Value

dboptions.integratedparams.BATCHSQL_MODE 
Batch SQL Mode

dboptions.integratedparams.CDGRANULARITY 
Conflict Detection Granularity

dboptions.integratedparams.COMMIT_SERIALIZAT
ION 

Commit Serialization

dboptions.integratedparams.COMPARE_KEY_ONLY 
Compare Key Only

dboptions.integratedparams.COMPUTE_LCR_DEP_O
N_ARRIVAL 

Compute LCR Dependency On Arrival

dboptions.integratedparams.DISABLE_ON_ERROR 
Disable On Error

dboptions.integratedparams.DISABLE_ON_LIMIT 
Disable On Limit

dboptions.integratedparams.EAGER_SIZE 
Eager Size

dboptions.integratedparams.ENABLE_XSTREAM_TA
BLE_STATS 

Enable Table Statistics

dboptions.integratedparams.GROUPTRANSOPS 
Group Transaction Operations

dboptions.integratedparams.HANDLECOLLISIONS 
Handle Collisions

dboptions.integratedparams.IGNORE_TRANSACTIO
N 

Ignore Transaction

dboptions.integratedparams.MAXIMUM_SCN 
Max SCN
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

dboptions.integratedparams.MAX_PARALLELISM 
Max Parallelism

dboptions.integratedparams.MAX_SGA_SIZE 
Max SGA Size

dboptions.integratedparams.MESSAGE_TRACKING_
FREQUENCY 

Message Tracking Frequency

dboptions.integratedparams.OPTIMIZE_PROGRESS
_TABLE 

Optimize Progress Table

dboptions.integratedparams.OPTIMIZE_SELF_UPD
ATES 

Optimize Self Updates

dboptions.integratedparams.PARALLELISM 
Parallelism

dboptions.integratedparams.PARALLELISM_INTER
VAL 

Parallelism Interval

dboptions.integratedparams.PRESERVE_ENCRYPTI
ON 

Preserve Encryption

dboptions.integratedparams.RTRIM_ON_IMPLICIT
_CONVERSION 

RTRIM On Implicit Conversion

dboptions.integratedparams.STARTUP_SECONDS 
Startup Seconds

dboptions.integratedparams.SUPPRESSTRIGGERS 
Suppress Triggers

dboptions.integratedparams.TIME_LIMIT 
Time Limit

dboptions.integratedparams.TRACE_LEVEL 
Trace Level

dboptions.integratedparams.TRANSACTION_LIMIT 
Transaction Limit

dboptions.integratedparams.WRITE_ALERT_LOG 
Write Alert Log

dboptions.legacylobreplication 
Legacy LOB Replication

dboptions.limitrows 
Limit Rows

dboptions.lobbufsize 
LOB Buffer Size

dboptions.lobwritesize 
LOB Write Size
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

dboptions.nofetchtimeout 
No Fetch Timeout

dboptions.reparselobsql 
Reparse LOB SQL

dboptions.sessionpoolincr 
Session Pool Increase

dboptions.sessionpoolmax 
Session Pool Max

dboptions.sessionpoolmin 
Session Pool Min

dboptions.settag 
Set Tag

dboptions.showinfomessages 
Show Info Messages

dboptions.showwarnings 
Show Warnings

dboptions.skiptemplob 
Skip Temp LOB

dboptions.sourcedbname 
Source DB Name

dboptions.sourcerootname 
Source CDB Root Name

dboptions.spthread 
SP Thread

dboptions.suppresstemporalupdates 
Edit Temporal Updates

dboptions.suppresstriggers 
Suppress Triggers

dboptions.tdspacketsize 
TDS Packet Size

dboptions.trustedconnection 
Trusted Connection

dboptions.useodbc 
Use ODBC

dboptions.usereplicationuser 
Use Replication User

dboptions.xmlbufsize 
XML Buffer Size

ddl 
DDL Operations

ddl.exclude 
Exclude
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

ddl.exclude.all 
All

ddl.exclude.allcatalogs 
All Catalogs

ddl.exclude.allowemptyobject 
Allow Empty Object

ddl.exclude.allowemptyowner 
Allow Empty Owner

ddl.exclude.eventactions 
EventActions

ddl.exclude.instr 
Instring

ddl.exclude.instrcomments 
Instring Comments

ddl.exclude.instrcommentswords 
Instring Comments Words

ddl.exclude.instrwords 
Instring Words

ddl.exclude.mapped 
Mapped

ddl.exclude.objname 
Object Name

ddl.exclude.objtype 
Object Type

ddl.exclude.optype 
Operation Type

ddl.exclude.other 
Other

ddl.exclude.sourcecatalog 
Source Catalog

ddl.exclude.staymetadata 
Stay Metadata

ddl.exclude.unmapped 
Unmapped

ddl.include 
Include

ddl.include.all 
All

ddl.include.allcatalogs 
All Catalogs

ddl.include.allowemptyobject 
Allow Empty Object
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

ddl.include.allowemptyowner 
Allow Empty Owner

ddl.include.eventactions 
EventActions

ddl.include.instr 
Instring

ddl.include.instrcomments 
Instring Comments

ddl.include.instrcommentswords 
Instring Comment Words

ddl.include.instrwords 
Instring Words

ddl.include.mapped 
Mapped

ddl.include.objname 
Object Name

ddl.include.objtype 
Object Type

ddl.include.optype 
Operation Type

ddl.include.other 
Other

ddl.include.sourcecatalog 
Source Catalog

ddl.include.staymetadata 
Stay Metadata

ddl.include.unmapped 
Unmapped

ddlerror 
DDL Error

ddlerror.abendmissingobjects 
Abend on Missing Objects

ddlerror.abendmissingtables 
Abend on Missing Tables

ddlerror.error_code 
Error Code

ddlerror.error_code.abend 
Abend

ddlerror.error_code.discard 
Discard

ddlerror.error_code.exclude 
Exclude
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Oracle GoldenGate Parameter/Option Oracle GoldenGate Studio Label

ddlerror.error_code.exclude.all 
All

ddlerror.error_code.exclude.allcatalogs 
All Catalogs

ddlerror.error_code.exclude.allowemptyobject 
Allow Empty Object

ddlerror.error_code.exclude.allowemptyowner 
Allow Empty Owner

ddlerror.error_code.exclude.eventactions 
Event Actions

ddlerror.error_code.exclude.instr 
Instring

ddlerror.error_code.exclude.instrcomments 
Instring Comments

ddlerror.error_code.exclude.instrcommentswor
ds 

Instruction Comments Words

ddlerror.error_code.exclude.instrwords 
Instruction Words

ddlerror.error_code.exclude.mapped 
Mapped

ddlerror.error_code.exclude.objname 
Object Name

ddlerror.error_code.exclude.objtype 
Object Type

ddlerror.error_code.exclude.optype 
Operation Type

ddlerror.error_code.exclude.other 
Other

ddlerror.error_code.exclude.sourcecatalog 
Source Catalog

ddlerror.error_code.exclude.staymetadata 
Stay Metadata

ddlerror.error_code.exclude.unmapped 
Unmapped

ddlerror.error_code.ignore 
Ignore

ddlerror.error_code.include 
Include

ddlerror.error_code.include.all 
All

ddlerror.error_code.include.allcatalogs 
All Catalogs
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ddlerror.error_code.include.allowemptyobject 
Allow Empty Object

ddlerror.error_code.include.allowemptyowner 
Allow Empty Owner

ddlerror.error_code.include.eventactions 
Event Actions

ddlerror.error_code.include.instr 
Instring

ddlerror.error_code.include.instrcomments 
Instring Comments

ddlerror.error_code.include.instrcommentswor
ds 

Instruction Comments Words

ddlerror.error_code.include.instrwords 
Instruction Words

ddlerror.error_code.include.mapped 
Mapped

ddlerror.error_code.include.objname 
Object Name

ddlerror.error_code.include.objtype 
Object Type

ddlerror.error_code.include.optype 
Operation Type

ddlerror.error_code.include.other 
Other

ddlerror.error_code.include.sourcecatalog 
Source Catalog

ddlerror.error_code.include.staymetadata 
Stay Metadata

ddlerror.error_code.include.unmapped 
Unmapped

ddlerror.error_code.retryop 
Retry Operation

ddlerror.error_code.retryop.maxretries 
Max Retries

ddlerror.error_code.retryop.retrydelay 
Retry Delay

ddlerror.ignoremissingobjects 
Ignore Missing Objects

ddlerror.ignoremissingtables 
Ignore Missing Tables

ddlerror.norestartcollisions 
Do Not Restart With HandleCollisions
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ddlerror.restartcollisions 
Restart With HandleCollisions

ddlerror.restartskip 
Restart And Skip

ddlerror.skiptriggererror 
Skip Trigger Error

ddloptions 
DDL Options

ddloptions.NOADDTRANDATA 
No Add Trandata

ddloptions.NOCAPTUREGLOBALTEMPTABLE 
No Capture Global Temp Table

ddloptions.NOCROSSRENAME 
No Cross Rename

ddloptions.USEPASSWORDVERIFIERLEVEL 
Use Password Verifier Level

ddloptions.addtrandata 
Add Trandata

ddloptions.addtrandata.abend 
Abend

ddloptions.addtrandata.retryop 
Retry Operation

ddloptions.addtrandata.retryop.maxretries 
Max Retries

ddloptions.addtrandata.retryop.retrydelay 
Retry Delay

ddloptions.captureglobaltemptable 
Capture Global Template

ddloptions.defaultuserpassword 
Default User Password

ddloptions.defaultuserpassword.aes128 
AES128

ddloptions.defaultuserpassword.aes192 
AES192

ddloptions.defaultuserpassword.aes256 
AES256

ddloptions.defaultuserpassword.blowfish 
Blowfish

ddloptions.defaultuserpassword.encryptkey 
Encrypt Key

ddloptions.defaultuserpasswordalias 
Default User Password Alias
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ddloptions.defaultuserpasswordalias.domain 
Domain

ddloptions.getapplops 
Get Application Operations

ddloptions.getreplicates 
Get Replicat Transactions

ddloptions.ignoremapping 
Ignore Mapping

ddloptions.mapderived 
Map Derived

ddloptions.mapschemas 
Map Schemas

ddloptions.mapsessionschema 
Map Session Schema

ddloptions.noremovecomments 
Don't Remove Comments

ddloptions.notag 
No Tag

ddloptions.password 
Password

ddloptions.password.aes128 
AES128

ddloptions.password.aes192 
AES192

ddloptions.password.aes256 
AES256

ddloptions.password.blowfish 
Blowfish

ddloptions.password.encryptkey 
Encryption Key

ddloptions.removecomments 
Remove Comments

ddloptions.replicatepassword 
Replicate Password

ddloptions.report 
Log DDL Operations To Report File

ddloptions.target 
Target

ddloptions.updatemetadata 
Update Metadata

ddloptions.useownerforsession 
Use Owner for Session
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ddlrulehint 
DDL Rule Hint

ddlsubst 
DDL Substitution

ddlsubst.allcatalogs 
All Catalogs

ddlsubst.allowemptyobject 
Allow Empty Object

ddlsubst.allowemptyowner 
Allow Empty Owner

ddlsubst.eventactions 
Event Actions

ddlsubst.exclude 
Exclude

ddlsubst.exclude.all 
All

ddlsubst.exclude.mapped 
Mapped

ddlsubst.exclude.other 
Other

ddlsubst.exclude.unmapped 
Unmapped

ddlsubst.include 
Include

ddlsubst.include.all 
All

ddlsubst.include.mapped 
Mapped

ddlsubst.include.other 
Other

ddlsubst.include.unmapped 
Unmapped

ddlsubst.instr 
Apply to String

ddlsubst.instrcomments 
Comments

ddlsubst.instrcommentswords 
Comment Words

ddlsubst.instrwords 
Apply to Instructions

ddlsubst.objname 
Object Name
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ddlsubst.objtype 
DB Object Type

ddlsubst.optype 
DDL Operation Type

ddlsubst.sourcecatalog 
Source Catalog

ddlsubst.staymetadata 
Stay meta data

ddlsubst.with 
With

ddltable 
DDL Table Name Override

decrypttrail 
Decrypt Trail

decrypttrail.algorithm 
Algorithm

decrypttrail.aes128 
AES128

decrypttrail.aes192 
AES192

decrypttrail.aes256 
AES256

decrypttrail.keyname 
Key Name

deferapplyinterval 
Defer Apply Interval

defsfile 
DEFGEN Definition File

defsfile.append 
Append

defsfile.charset 
Character Set

defsfile.format 
Format Release

defsfile.format.level 
Level

defsfile.format.release 
Release

defsfile.purge 
Purge

deletelogrecs 
Delete Log Records
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discardfile 
Discard File

discardfile.append 
Append

discardfile.maxbytes 
Max Bytes

discardfile.megabytes 
Megabytes

discardfile.purge 
Purge

discardrollover 
Discard Rollover

discardrollover.at 
At

discardrollover.on 
On

downcritical 
Down Critical

downinfo 
Down Info

downreporthours 
Down Report Hours

downreportminutes 
Down Report Minutes

dsoptions 
Teradata Data Server Options

dsoptions.checkopcomplete 
Check Op Complete

dsoptions.checktrandata 
Check Trandata

dsoptions.committedtranlog 
Committed Tranlog

dsoptions.createtranlog 
Create Tranlog

dsoptions.excludetrans 
Exclude Tranlog

dsoptions.excludeuser 
Exclude User

dsoptions.excludeuserid 
Exclude User ID

dsoptions.ignoremetadatafromvam 
Ignore VAM Metadata
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dsoptions.restartappend 
Restart Append

dsoptions.sorttranlog 
Sort Tranlog

dsoptions.vamcompatibility 
VAM Compatibility

dumpddlcolumns 
Dump DDL Columns

dumpddlloggroups 
Dump DDL Log Groups

dumpddlobjects 
Dump DDL Objects

dumpddlpartitions 
Dump DDL Partitions

dumpddlprimarykeys 
Dump DDL Primary Keys

dynamicportlist 
Dynamic Port List

dynamicportreassigndelay 
Dynamic Port Reassign Delay

dynamicresolution 
Dynamic Resolution

dynsql 
Dynamic SQL

ebcdicmixedccsid 
EBCDIC Mixed CCSID

ebcdictoascii 
EBCDIC to ASCII

enablecatalognames 
Enable Catalog Names

enableheartbeat 
Enable Heartbeat

enablemonitoring 
Enable Monitoring

enablemonitoring.bdb 
BDB (Berkeley DB)

enablemonitoring.lmdb 
LMDB (Lightning DB)

enablemonitoring.shmid 
SHMID (Shared Memory ID)

enablenewmanager 
Enable New Manager
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encrypttrail.0 
Encrypt Trail

encrypttrail.1
Algorithm

encrypttrail.keyname 
Key Name

end 
End

eofdelay 
EOF Delay (seconds)

eofdelaycsecs 
EOF Delay (centiseconds)

etoldformat 
ET Old Format

excludetag 
Exclude Tag

excludewildcardobjectsonly 
Exclude Wildcard Objects Only

extfile 
Extract File

extfile.format 
Format Release

extfile.level 
Format Level

extfile.maxfiles 
Max Files

extfile.megabytes 
Megabytes

extfile.objectdefs
Object Definitions

extfile.purge
Purge

extfile.release
Release

extfile.trailbyteorder 
Trail Byte Order

extract
Extract

exttrail
Trail

exttrail.format 
Format Release
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exttrail.level 
Format Level

exttrail.objectdefs 
Object Definitions

exttrail.release 
Format Release

exttrail.trailbyteorder 
Trail Byte Order

fetchoptions 
Fetch Options

fetchoptions.detaileddiagnostics 
Detailed Diagnostics

fetchoptions.diagnosticsonall 
Diagnostics On All

fetchoptions.fetchpkupdatecols 
Fetch PK Updates Columns

fetchoptions.inconsistentrow 
Inconsistent Row

fetchoptions.maxfetchstatements 
Max Fetch Statements

fetchoptions.missingrow 
Missing Row

fetchoptions.nofetch 
No Fetch

fetchoptions.nosuppressduplicates 
No Suppress Duplicates

fetchoptions.usediagnostics 
Use Diagnostics

fetchoptions.usekey 
Use Key

fetchoptions.uselatestversion 
Use Latest Version

fetchoptions.userowid 
Use Row ID

fetchoptions.usesnapshot 
Use Snapshot

fetchuserid 
Fetch User ID

fetchuserid.algorithm 
Algorithm

fetchuserid.encryptkey 
Encrypt Key
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fetchuserid.password 
Password

fetchuserid.sysdba 
Sysdba

filterdups 
Filter Duplicates

flushcsecs 
Flush Memory Buffer (csecs)

flushsecs 
Flush (secs)

formatascii 
Format ASCII

formatascii.bcp 
MSSQL Bulk Load

formatascii.charset 
Character Set

formatascii.date 
Date Time Format

formatascii.delimiter 
Delimiter

formatascii.extracols 
Extra Columns

formatascii.ind 
Include Before and After Ind

formatascii.names 
Include Columns Names

formatascii.nohdrfields 
Suppress Header Fields

formatascii.noquote 
Exclude Quotes

formatascii.nullisspace 
Convert Null to Blank

formatascii.op 
Include Operation Type

formatascii.placeholders 
Placeholders

formatascii.sqlloader 
Oracle SQL Loader

formatascii.time 
Time

formatascii.ts 
Timestamp
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formatsql 
Write SQL Format File

formatsql.nonames 
Omit Column Names

formatsql.nopkupdates 
No PK Updates

formatsql.oracle 
Oracle Date-Times

formatxml 
Format XML

formatxml.encoding 
Encoding

formatxml.inlineproperties 
Write Properties Inline With XML Tab

formatxml.trans 
Include Commit Markers

functionstacksize 
Function Stack Size

genloadfiles 
Generate Load Files

genloadfiles.charset 
Character Set

getalters 
Get Alters

getapplops 
Get Application Operations

getcreates 
Get Creates

getdeletes 
Get Deletes

getdrops 
Get Drops

getenv 
Get Environment

getinserts 
Get Inserts

getreplicates 
Get Replicat Transactions

gettruncates 
Get Truncates

getupdateafters 
Get Update After Images
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getupdatebefores 
Get Updates Before Images

getupdates 
Get Updates

ggschema 
Schema Name

grouptransops 
Group Transaction Operations

handlecollisions 
Handle Collisions

handlecollisions.thread 
Threads

handletpkupdate 
Handle Transient Primary-Key Update

haveudtwithnchar 
User Data Type Contains NCHAR

heartbeat_table 
Heartbeat Table

ignore_unrecognized 
Ignore Unrecognized

include 
Include

initializeheap 
Initialize Heap

insertallrecords 
Insert All Records

insertappend 
Insert Append

insertdeletes 
Insert Deletes

insertmissingupdates 
Convert failed updates to inserts

insertupdates 
Insert Updates

jvmadditionalopts 
JVM Additional Options

jvmclasspath 
JVM Classpath

jvmcompiler 
JVM Compiler

jvmentryclass 
JVM Entry Class
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jvmentrymethod 
JVM Entry Method

jvmentrymethodarguments 
JVM Entry Method Arguments

jvmentrymethodsignature 
JVM Entry Method Signature

jvmlibrarypath 
JVM Library Path

lagcriticalhours 
Critical Hours Lag Threshold

lagcriticalminutes 
Critical Minutes Lag Threshold

lagcriticalseconds 
Critical Seconds Lag Threshold

laginfohours 
Info Hours Lag Threshold

laginfominutes 
Info Minutes Lag Threshold

laginfoseconds 
Lag Info Seconds

lagreporthours 
Report Hours Lag Threshold

lagreportminutes 
Report Minutes Lag Threshold

lfmmemory 
LFM (Long Field Memory)

lfmmemory.directory 
Directory

lfmmemory.inittransram 
Init Trans RAM

lfmmemory.ram 
RAM

lfmmemory.ramincrement 
RAM Increment

lfmmemory.transallsources 
Trans All Sources

lfmmemory.transram 
Trans RAM

list 
List

lobmemory 
LOB Memory
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lobmemory.directory 
Directory

lobmemory.inittransram 
Init Trans RAM

lobmemory.ram 
RAM

lobmemory.ramincrement 
RAM Increment

lobmemory.transallsources 
Trans All Sources

lobmemory.transram 
Trans RAM

logallsupcols 
Capture All Supplementally Logged
Columns

logfilesbehind 
Log Files Behind

logfilesbehindinfo 
Log Files Behind Message

macro 
Macro

macro.begin 
Body

macro.params 
Parameters

macrochar 
Macro Character

mapexclude 
Map Exclude

mapexclude.norename 
No Rename

mapinvisiblecolumns 
Map Invisible Columns

mapinvisiblecolumns.thread 
Thread

markertable 
Marker Table

masterkeyname 
Master Key Name

masterkeyname.version 
Version

maxabendrestarts 
Max Abend Restarts
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maxdiscardrecs 
Max Discard Records

maxetcheckptsecs 
Max Checkpoint Seconds

maxfetchstatements 
Max Fetch Statements

maxfieldlen 
Max Field Length

maxgroups 
Max Process Groups

maxsqlstatements 
Max SQL Statements

maxtaclrestarts 
Max Tacl Restarts

maxtransops 
Max Transaction Operations

maxtraprestarts 
Max Trap Restarts

mgrservname 
Manager Server Name

monitoring_heartbeat_timeout 
Monitoring Heartbeat Timeout (secs)

nameccsid 
DB Name CCSID

namematchexact 
Exact Match

namematchignorecase 
Ignore Case

namematchnowarning 
No Name Match Warning

noasciiformat 
No ASCII Format

nocatalog 
Remove Catalog Name

nodiscardfile 
Disallow Discard File

nodupmsgsuppression 
Disallow Duplicate Message Suppression

noencrypttrail 
Disallow Encrypt Trail

nosqlformat 
No SQL Format
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nostats 
Disable Performance Statistics

notracetable 
Disallow Trace Table

nouserid 
No User ID

nousethreads 
Disallow Use Threads

numfiles 
Memory Structures Initial Number

obey 
Obey

outputfileumask 
Output File umask

overridedups 
Override Duplicates

param_parse_error 
Parameter Parsing Error

param_parse_error.force 
Force

passthru 
Enable PassThru

passthrumessages 
Enable PassThru Messages

port 
Port

preservetargettimezone 
Preserve Target Timezone

ptkcapturebatchsql 
Capture Batch SQL Statistics

ptkcapturecachemgr 
Capture Cache Statistics

ptkcaptureift 
Capture Inflight Transactions

ptkcapturenetwork 
Capture Network Statistics

ptkcaptureprocstats 
Enable Process/Thread Statistics

ptkcapturequeuestats 
Capture Queue Statistics

ptkcapturetablestats 
Capture Table Statistics
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ptkirstatsfrequency 
Statistics Frequency

ptkmaxtables 
Max Tables for Statistics

ptkmonitorfrequency 
Monitoring Collection Frequency (sec)

ptkspstats 
Capture Superpool Statistics

ptktablepollfrequency 
Poll Interval for Table Statistics

purgeddlhistory 
Purge DDL_HISTORY

purgeddlhistory.frequencyhours 
Frequency Hours

purgeddlhistory.frequencyminutes 
Frequency Minutes

purgeddlhistory.maxkeepdays 
Max Keep Days

purgeddlhistory.maxkeephours 
Max Keep Hours

purgeddlhistory.minkeepdays 
Minimum Keep Days

purgeddlhistory.minkeephours 
Minimum Keep Hours

purgeddlhistoryalt 
Purge DDL_HISTORY_ALT

purgeddlhistoryalt.frequencyhours 
Frequency Hours

purgeddlhistoryalt.frequencyminutes 
Frequency Minutes

purgeddlhistoryalt.maxkeepdays 
Max Keep Days

purgeddlhistoryalt.maxkeephours 
Max Keep Hours

purgeddlhistoryalt.minkeepdays 
Minimum Keep Days

purgeddlhistoryalt.minkeephours 
Minimum Keep Hours

purgemarkerhistory 
Purge MARKER_HISTORY table

purgemarkerhistory.frequencyhours 
Frequency Hours
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purgemarkerhistory.frequencyminutes 
Frequency Minutes

purgemarkerhistory.maxkeepdays 
Max Keep Days

purgemarkerhistory.maxkeephours 
Max Keep Hours

purgemarkerhistory.minkeepdays 
Minimum Keep Days

purgemarkerhistory.minkeephours 
Minimum Keep Hours

purgeoldextracts 
Purge Old Extracts

purgeoldextracts.frequencyhours 
Frequency Hours

purgeoldextracts.frequencyminutes 
Frequency Minutes

purgeoldextracts.maxkeepdays 
Max Keep Days

purgeoldextracts.maxkeepfiles 
Max Keep Files

purgeoldextracts.maxkeephours 
Max Keep Hours

purgeoldextracts.minkeepdays 
Minimum Keep Days

purgeoldextracts.minkeepfiles 
Minimum Keep Files

purgeoldextracts.minkeephours 
Minimum Keep Hours

purgeoldextracts.usecheckpoints 
Use Checkpoints

purgeoldhistory 
Purge Old History

purgeoldhistory.maxkeepdays 
Max Keep Days

purgeoldhistory.maxkeephours 
Max Keep Hours

purgeoldhistory.minkeepdays 
Minimum Keep Days

purgeoldhistory.minkeephours 
Minimum Keep Hours

purgeoldtasks 
Purge Old Tasks
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purgeoldtasks.after 
After

purgeoldtasks.er 
Extract/Replicat

purgeoldtasks.extract 
Extract

purgeoldtasks.replicat 
Replicat

purgeoldtasks.usestopstatus 
Use Top Status

randomrollbacks 
Random Rollbacks

recoveryoptions 
Recovery Options

recoveryoptions.appendmode 
Append Mode

recoveryoptions.overwritemode 
Overwrite Mode

reperror 
Replicat Error

reperror.reset 
Reset

repfetchedcoloptions 
Replicat Fetched Column Options

repfetchedcoloptions.inconsistentrow 
Inconsistent Row

repfetchedcoloptions.latestrowversion 
Latest Row Version

repfetchedcoloptions.missingrow 
Missing Row

repfetchedcoloptions.nofetch 
Prevent Fetch

repfetchedcoloptions.redundantrow 
Redundant Row

repfetchedcoloptions.setifmissing 
Set If Missing

repfetchedcoloptions.snapshotrow 
Snapshot Row

replacebadchar 
Replaces Invalid Character

replacebadchar.abort 
Abort
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replacebadchar.enablefallback 
Enable Fallback

replacebadchar.escape 
Escape

replacebadchar.forcecheck 
Force Check

replacebadchar.nowarning 
No Warning

replacebadchar.null 
Null

replacebadchar.skip 
Skip

replacebadchar.space 
Space

replacebadchar.substitute 
Substitute

replacebadchar.unprintable 
Unprintable

replacebadnum 
Replace Invalid Numbers

replicat 
Replicat

repobackupdir 
Repository Backup Directory

repobackupfrequency 
Repository Backup Frequency

reponumbackupsbeforefullbackup 
Repository Backups Before Full Backup

report 
Report

report.AT 
At

report.ON 
On

reportcount 
Transaction Record Report Count

reportcount.every 
Every

reportcount.rate 
Report Rate

reportformatnoremote 
Report Format No Remote
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reportrollover 
Report Rollover

reportrollover.AT 
At

reportrollover.ON 
On

restartcollisions 
Restart Collisions

restartinterval 
Restart Interval

retrydelay 
Retry Delay

rmtfile 
Remote File

rmtfile.append 
Append

rmtfile.format 
Format Release

rmtfile.level 
Format Level

rmtfile.maxfiles 
Max Files

rmtfile.megabytes 
Megabytes

rmtfile.objectdefs 
Object Definitions

rmtfile.purge 
Purge

rmtfile.release 
Format Release

rmtfile.trailbyteorder 
Trail Byte Order

rmthost 
Remote Host

rmthost.compress 
Compress

rmthost.compressthreshold 
Compress Threshold

rmthost.cpu 
CPU

rmthost.encrypt 
Encrypt
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rmthost.hometerm 
Device

rmthost.keyname 
Key Name

rmthost.mgrport 
Manager Port

rmthost.nostreaming 
No Streaming

rmthost.params 
Parameters

rmthost.password 
Password

rmthost.port 
Collector Port

rmthost.pri 
Priority

rmthost.processname 
Process Name

rmthost.socksproxy 
Socks Proxy

rmthost.socksproxy.proxycsalias 
Proxy Credential Store Alias

rmthost.socksproxy.proxycsdomain 
Proxy Credential Store Domain

rmthost.streaming 
Streaming

rmthost.tcpbufsize 
TCP Buffer Size

rmthost.tcpflushbytes 
TCP Flush Bytes

rmthost.timeout 
Timeout

rmthost.user 
User ID

rmthostoptions 
Remote Host Options

rmthostoptions.compress 
Compress

rmthostoptions.compressthreshold 
Compress Threshold

rmthostoptions.encrypt 
Encrypt
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rmthostoptions.keyname 
Key Name

rmthostoptions.nostreaming 
No Streaming

rmthostoptions.params 
Parameters

rmthostoptions.streaming 
Streaming

rmthostoptions.tcpbufsize 
TCP Buffer Size

rmthostoptions.tcpflushbytes 
TCP Flush Bytes

rmthostoptions.timeout 
Timeout

rmttask 
Remote Task

rmttask.format 
Format Release

rmttask.group 
Group

rmttask.level 
Format Level

rmttask.params 
Parameters

rmttask.release 
Format Release

rmttrail 
Remote Trail

rmttrail.format 
Format Release

rmttrail.level 
Format Level

rmttrail.objectdefs 
Object Definitions

rmttrail.release 
Format Release

rmttrail.trailbyteorder 
Trail Byte Order

rollover 
Rollover

rollover.at 
At
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rollover.on 
On

rollover.report 
Report

schemaexclude 
Exclude Replicat Schema

schemaexclude.norename 
No Rename

sequence 
Sequence

sessioncharset 
Session Character Set

setenv 
Set Environment

showsyntax 
Show SQL Syntax

showsyntax.all 
All

showsyntax.includelob 
Include LOB

showsyntax.noapply 
No Apply

sourcecatalog 
Source Catalog

sourcecharset 
Source Character Set

sourcecharset.character_set_name 
Character Set Name

sourcecharset.db2zos 
DB2 On z/OS

sourcecharset.override 
Override

sourcecharset.passthru 
PassThru

sourcedb 
Source DB

sourcedb.credentialgroup 
Credential Group

sourcedb.domain 
Domain

sourcedb.encryptkey 
Encrypt Key
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sourcedb.password 
Password

sourcedb.password.aes128 
AES128

sourcedb.password.aes192 
AES192

sourcedb.password.aes256 
AES256

sourcedb.password.blowfish 
Blowfish

sourcedb.sessioncharset 
Session Character Set

sourcedb.sqlid 

sourcedb.sysdba 
Sysdba

sourcedb.thread 
Threads

sourcedb.userid 
User ID

sourcedb.useridalias 
User Alias

sourcedefs 
Source Definitions

sourcedefs.override 
Override

sourceisfile 
Source Is File

sourceistable 
Source Is Table

sourcetimezone 
Source Timezone

spacestonull 
Convert Spaces to Null

specialrun 
Special Run

sqlduperr 
SQL Duplicate Error

sqlexec 
SQL Execution

sqlexec.every 
Every
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sqlexec.onexit 
On Exit

sqlexec.thread 
Thread

startupvalidationdelay 
Startup Validation Delay (secs)

startupvalidationdelaycsecs 
Startup Validation Delay (csecs)

statoptions 
Statistic Options

statoptions.reportcharconv 
Report Character Conversion

statoptions.reportdetail 
Operation Statistics

statoptions.reportfetch 
Fetch Statistics

statoptions.resetreportstats 
Reset Report Statistics

statoptions.thread 
Thread

syslog 
Sys Log

syslog.all 
All

syslog.error 
Error

syslog.info 
Info

syslog.none 
None

syslog.warn 
Warning

tableexclude 
Exclude Table

tableexclude.norename 
No Rename

targetdb 
Target DB

targetdb.domain 
Domain

targetdb.dsn 
DSN
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targetdb.encryptkey 
Encrypt Key

targetdb.libfile 
Library File

targetdb.password 
Password

targetdb.password.aes128 
AES128

targetdb.password.aes192 
AES192

targetdb.password.aes256 
AES256

targetdb.password.blowfish 
Blowfish

targetdb.sessioncharset 
Session Character Set

targetdb.set 
Set

targetdb.sqlid 
SQL ID

targetdb.sysdba 
Sysdba

targetdb.thread 
Threads

targetdb.userid 
User ID

targetdb.useridalias 
User Alias

targetdefs 
Target Definitions

targetdefs.override 
Override

tcpsourcetimer 
Compensate For System Clock Differences

threadoptions 
Thread Options

threadoptions.eofdelaycsecs 
EOF Delay Centiseconds

threadoptions.eofdelayms 
EOF Delay (ms)

threadoptions.except 
Except
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threadoptions.inqueuesize 
Input Queue Size

threadoptions.outqueuesize 
Output Queue Size

threadoptions.processthreads 
Process Threads

threadoptions.select 
Select

threadoptions.stacksize 
Stack Size

tltrace 
Transaction Log Trace

tltrace.data 
Use Raw Format

tltrace.ddl 
DDL

tltrace.debug 
Debug

tltrace.file 
File

tltrace.level 
Level

tltrace.pause 
Pause

trace 
Trace

trace2 
Trace2

traceapi 
Trace API

tracetable.0 
Trace Table

tracetable.1 
Name

trail_seqlen_9d 
Trail Sequence Length 9 digits

trailbyteorder 
Trail Byte Order

trailcharset 
Trail Character Set

trailcharset.replacebadchar 
Replace Bad Character
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trailcharsetascii 
Trail Character Set ASCII

trailcharsetebcdic 
Trail Character Set EBCDIC

trailcharsetunicode 
Unicode Trail Character Set

tranlogoptions 
Transaction Log Options

tranlogoptions.USE_ROOT_CONTAINER_TIMEZONE 
Use Root Container Timezone

tranlogoptions._allowtablecompression 
Allow Table Compression

tranlogoptions.activationidpadlen 
Activation ID Pad Length

tranlogoptions.activesecondarytruncationpoin
t 

Active Secondary Truncation

tranlogoptions.adgapplycheckfreq 
ADG Apply Check Frequency

tranlogoptions.adgretrycount 
ADG Retry Count

tranlogoptions.adgtimeout 
ADG Timeout

tranlogoptions.allowdataloss 
Allow Data Loss

tranlogoptions.allowtablecompression 
Allow Table Compression

tranlogoptions.altarchivedlogformat 
Alt Archive Log Format

tranlogoptions.altarchivelogdest 
Alt Archive Log Destination

tranlogoptions.altlogdest 
Alt Log Destination

tranlogoptions.altonlinelogs 
Alt Online Logs

tranlogoptions.apifilter 
API Filter

tranlogoptions.archivedlogonly 
Archived Log Only

tranlogoptions.archiverestoreexecutable 
Archive Restore Executable

tranlogoptions.archiverestoreparams 
Archive Restore Parameters
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tranlogoptions.asmbufsize 
ASM Buffer Size

tranlogoptions.asmuser 
ASM User

tranlogoptions.asmuser.aes128 
AES128

tranlogoptions.asmuser.aes192 
AES192

tranlogoptions.asmuser.aes256 
AES256

tranlogoptions.asmuser.asmpassword 
ASM Password

tranlogoptions.asmuser.blowfish 
Blowfish

tranlogoptions.asmuser.encryptkey 
Encrypt Key

tranlogoptions.asmuser.sysdba 
Sysdba

tranlogoptions.asmuseralias 
ASM User Alias

tranlogoptions.asmuseralias.domain 
Domain

tranlogoptions.asynctransprocessing 
Async Transaction Processing

tranlogoptions.bufsize 
Buffer Size

tranlogoptions.checkpointretentiontime 
Checkpoint Retention

tranlogoptions.checkpointtable 
Checkpoint Table

tranlogoptions.checkposition 
Check Position

tranlogoptions.checktablelevelsupplog 
Checktable Level Suppl Log

tranlogoptions.completearchivedlogonly 
Complete Archived Log

tranlogoptions.completearchivedlogtimeout 
Complete Archived Log Timeout

tranlogoptions.convertucs2clobs 
Convert UCS to CLOBS

tranlogoptions.createtranlog 
Create Transaction Log
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tranlogoptions.databaseidpadlen 
Database ID Pad Len

tranlogoptions.dblogreader 
DB Log Reader

tranlogoptions.dblogreaderbufsize 
DB Log Reader Buffer Size

tranlogoptions.excludetag 
Exclude Tag

tranlogoptions.excludetrans 
Exclude Transaction

tranlogoptions.excludeuser 
Exclude User

tranlogoptions.excludeuserid 
Exclude User ID

tranlogoptions.failovertargetdestid 
Failover Target Destination ID

tranlogoptions.fetchinlinesflob 
Fetch Inline FS Lob

tranlogoptions.fetchlobonerror 
Fetch LOB On Error

tranlogoptions.fetchpartiallob 
Fetch Partial LOB

tranlogoptions.fetchpartialxml 
Fetch Partial XML

tranlogoptions.fetchxmlonerror 
Fetch XML On Error

tranlogoptions.filtertable 
Filter Table

tranlogoptions.flush 
Flush

tranlogoptions.forcefetchlob 
Force Fetch LOB

tranlogoptions.getctasdml 
Get CTAS DML

tranlogoptions.getmetadatafromvam 
Get Metadata From VAM

tranlogoptions.handledlfailover 
Handled Failover

tranlogoptions.iflockseconds 
If Lock (secs)

tranlogoptions.ignoredatacapturechanges 
Ignore Data Capture Changes
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tranlogoptions.ignoredirectloadinserts 
Ignore Direct Load Inserts

tranlogoptions.ignoregap 
Ignore Gap

tranlogoptions.ignorekeyerror 
Ignore Key Error

tranlogoptions.includeaux 
Include AUX

tranlogoptions.includeregionid 
Include Region ID

tranlogoptions.includeregionidwithoffset 
Include Region ID With Offset

tranlogoptions.integratedparams 
Integrated Parameters

tranlogoptions.legacylobreading 
Legacy LOB Reading

tranlogoptions.logretention 
Log Retention

tranlogoptions.logretention.days 
Days

tranlogoptions.logsource 
Log Source

tranlogoptions.logswitchmsg 
Log Switch Message

tranlogoptions.managesecondarytruncationpoin
t 

Manage Secondary Truncation Point

tranlogoptions.maxparallelrec 
Max Parallel Records

tranlogoptions.maxreadsize 
Max Read Size

tranlogoptions.maxwarneof 
Max Warn EOF

tranlogoptions.minefromactivedg 
Mine From Active DG

tranlogoptions.minefromsnapshotstby 
Mine From Snapshots

tranlogoptions.mininguser 
Mining User

tranlogoptions.mininguser.algorithm 
Algorithm

tranlogoptions.mininguser.aes128 
AES128
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tranlogoptions.mininguser.aes192 
AES192

tranlogoptions.mininguser.aes256 
AES256

tranlogoptions.mininguser.blowfish 
Blowfish

tranlogoptions.mininguser.encryptkey 
Encrypt Key

tranlogoptions.mininguser.miningpassword 
Mining Password

tranlogoptions.mininguser.sysdba 
Sysdba

tranlogoptions.mininguseralias 
Mining User Alias

tranlogoptions.mininguseralias.domain 
Domain

tranlogoptions.noadgtimeout 
No ADG Timeout

tranlogoptions.noasynctransprocessing 
No Async Transaction Processing

tranlogoptions.noddlchangewarning 
No DDL Change Warning

tranlogoptions.noflush 
No Flush

tranlogoptions.noignoredatacapturechanges 
Do Not Ignore Data Capture

tranlogoptions.norequirelongdatacapturechang
es 

Do Not Require Long Data Capture

tranlogoptions.onephase 
One Phase

tranlogoptions.pathmap 
Path Map

tranlogoptions.pollinterval 
Poll Interval

tranlogoptions.prepareforupgradetoie 
Prepare For Upgrade To IE

tranlogoptions.purgeorphanedtransactions 
Purge Orphaned Transactions

tranlogoptions.queryretrycount 
Query Retry Count

tranlogoptions.readqueuesize 
Read Queue Size
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tranlogoptions.requirelongdatacapturechanges 
Require Long Data Capture

tranlogoptions.resetlogsidpadlen 
Reset Logs ID Pad Length

tranlogoptions.restartappend 
Restart Append

tranlogoptions.seqpadlen 
Sequence Pad Length

tranlogoptions.server 
Server

tranlogoptions.skipdirloadinsert 
Skip DIR Load Insert

tranlogoptions.startatactivelsn 
Start At Active LSN

tranlogoptions.threadpadlen 
Thread Pad Length

tranlogoptions.transcleanupfrequency 
Trans Cleanup Frequency (min)

tranlogoptions.truncpointoff 
Truncation Point Off

tranlogoptions.tslookupbeginlri 
Timestamp Lookup Start

tranlogoptions.tslookupendlri 
Timestamp Lookup Stop

tranlogoptions.unprivileged 
Unprivileged

tranlogoptions.usenativeobjsupport 
Use Native Object Support

tranlogoptions.useocithreads 
Use OCI Threads

tranlogoptions.useprevresetlogsid 
Use Previous Reset Log SID

tranlogoptions.userexit 
User Exit

tranlogoptions.validateinlinesflob 
Validate Inline FS Lob

tranlogoptions.vamcompatibility 
VAM Compatibility

transactiontimeout 
Transaction Timeout

transmemory 
Transaction Memory
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transmemory.directory 
Directory

transmemory.inittransram 
Initial Trans RAM

transmemory.ram 
RAM

transmemory.ramincrement 
RAM Increment

transmemory.transallsources 
Trans All Sources

transmemory.transram 
Trans RAM

trimspaces 
Trim CHAR to VARCHAR Spaces

trimvarspaces 
Trim VARCHAR to CHAR Spaces

unlockedtrailfiles 
Unlocked Trail Files

updatedeletes 
Update Deletes

updateinserts 
Update Inserts

updaterecordformat 
Update Record Format

upreporthours 
Up Report Hours

upreportminutes 
Up Report Minutes

use_traildefs 
Use Trail Definitions

usededicatedcoordinationthread 
Use Dedicated Coordination Thread

useipv4 
IPV4

useipv6 
IPV6

userid 
Userid

userid.password 
Password

userid.password.algorithm 
Algorithm
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userid.password.aes128 
AES128

userid.password.aes192 
AES192

userid.password.aes256 
AES256

userid.password.blowfish 
Blowfish

userid.password.encryptkey 
Encrypt Key

userid.sysdba 
Sysdba

userid.thread 
Threads

useridalias 
User Alias

useridalias.domain 
Domain

useridalias.sysdba 
Sysdba

useridalias.thread 
Threads

usethreads 
Use Threads

usetimeprefix 
Use Time Prefix

usetimestampprefix 
Use Timestamp Prefix

vam 
Vendor Access Module

vam.params 
Parameters

varwidthnchar 
Treat NCHAR, NVARCHAR2, NCLOB As
UTF-16

veridatareportage 
Veridata Report Age

walletlocation 
Wallet Location

warnlongtrans 
Warn Long Transaction

warnlongtrans.checkinterval 
Check Interval
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warnlongtrans.nousethreads 
No Use Threads

warnlongtrans.uselastreadtime 
Use Last Read Time

warnrate 
Warn Rate

wildcardresolve 
Resolve Wildcard

wildcardresolve.both 
Intermediate and Dynamic Resolve

wildcardresolve.dynamic 
Dynamic Resolve

wildcardresolve.ignoremissing 
Ignore Missing

wildcardresolve.immediate 
Immediate Resolve

xagenable 
XAG Integration
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C
Oracle Oracle GoldenGate Studio
Accessibility Information

Oracle Oracle GoldenGate Studio provides a wide range of features that are designed
to support accessibility. Our goal is to make Oracle Products, Services, and supporting
documentation accessible to the disabled community.

This appendix contains the following:

• Oracle GoldenGate Studio Features that Support Accessibility

• Highly Visual Features of Oracle GoldenGate Studio

C.1 Oracle GoldenGate Studio Features that Support
Accessibility

Oracle GoldenGate Studio provides a wide range of features that are designed to
support accessibility. Our goal is to make Oracle Products, Services, and supporting
documentation accessible to the disabled community.

Oracle GoldenGate Studio Features that Support Accessibility

The Oracle Accessibility Program web page provides information on how to configure
and use the accessibility features of Oracle GoldenGate Studio.

Oracle Oracle GoldenGate Studio supports accessibility features. For additional
accessibility information about Oracle products, including information on how to
configure and use them, see the Oracle Accessibility Program page at: Oracle's
Accessibility Program.

Oracle's goal is to ensure that disabled end-users of our products can perform the
same tasks, and access the same functionality as other users. Oracle Oracle
GoldenGate Studio provides a number of features that are designed to support
accessibility goals.

C.1.1 Keyboard Access
Oracle GoldenGate Studio features support keyboard access to several menu and
toolbar functionality so that users may navigate between windows and work with them,
or invoke resources.

Oracle GoldenGate Studio features support keyboard access to Oracle GoldenGate
Studio functionality; a summary is provided below. The mnemonic keys used to open
menus and choose commands are included in all procedural topics. Please refer to the
keyboard navigation topics for a summary of how keys are assigned within Oracle
GoldenGate Studio and the lists of accelerator keys provided for commands.

The following menu and toolbar functionality is provided through keyboard access:
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• Users can navigate to and invoke all menu items.

• All toolbar functions are accessible through menu items.

• All menus and menu items have unique and functioning mnemonic keys.

• All context menus within the windows and source editor can be invoked.

• Frequently used menu items have unique accelerator keys.

The following functionality is available in Oracle GoldenGate Studio dialogs and
wizards:

• You can navigate to and invoke all controls within all wizards and dialogs.

• The order in which the Tab key causes focus to flow is consistent and logical.

• Mnemonic keys are provided for controls where appropriate.

C.1.2 Screen Reader Readability
Screen readers in Oracle GoldenGate Studio ensure that menus and menu items,
toolbar items, hint text, open windows and components, status text, controls within
wizards, dialogs, and runtime applications are read.

The following is a summary of screen readability in Oracle GoldenGate Studio, when
it's used with a screen reader:

When used with menus and toolbars:

• All menus and menu items are read.

• All toolbar items, including the window toolbar items, are read.

• The hint text on all toolbar items is read.

When used with dialogs and wizards:

• All controls within all wizards and dialogs are read.

• Hint text is read.

When used with runtime applications:

• All controls within all runtime applications are read.

C.1.3 Flexibility in Font and Color Choices
For users who are visually challenged, Oracle GoldenGate Studio offers options in font
color, font size, and background color on user interfaces.

The user interface in Oracle GoldenGate Studio improves usability for people who are
visually impaired by offering flexibility in color and font choices. The following font and
color features are included:

• Users can specify both the font and the size in which the font displays for editors.

• All features of the product have black text on a white or gray background.

• Colored text, underlining or images are never used as the only method of
conveying information.

Appendix C
Oracle GoldenGate Studio Features that Support Accessibility

C-2



C.1.4 No Dependency on Blinking Cursor and Animation
By limiting its dependence on the use of a blinking cursor and animation, Oracle
GoldenGate Studio ensures greater feature accessibility.

Oracle GoldenGate Studio makes minimal use of a blinking cursor and animation. No
features in Oracle GoldenGate Studio use blinking indicators, with the exception of the
cursor in the source editor. No features rely on animated sequences.

C.1.5 Screen Magnifier Usability
The Oracle GoldenGate Studio user interface works well with screen magnifiers. All
features of the product can be magnified by a screen magnifier.

C.2 Highly Visual Features of Oracle GoldenGate Studio
Oracle GoldenGate Studio supports some very visual features. Visually challenged
users can access the UI, the visual editors, and the Components window using the
equivalent functionality in Oracle GoldenGate Studio.

Oracle GoldenGate Studio includes features that are highly visual, and these features
have equivalent functionality that is available to people who are blind or visually
impaired:

• The UI and visual editors. The source editor provides equivalent functionality, as
pages and UI elements can be completely designed and coded in the source
editor.

• The Components window. The source editor provides equivalent functionality, as
elements and tags that can be selected from the Components window can also be
entered in the source editor.

You can add a component from the Components window to the UI or visual editor
using keystrokes.

Oracle GoldenGate Studio also includes modeling features. It is possible to create,
edit and move elements on a diagram using only keystrokes.
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